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Summary

The acoustic ray trace model LYBIN is a well-established and frequently used sonar prediction
model owned by the Norwegian Defence Materiel Agency (NDMA). The model is used aboard
navy vessels as well as in training situations on shore. LYBIN has become an important tool in
both planning and evaluation of maritime operations. Earlier versions are already integrated in
combat system software, decision aids and tactical trainers.

LYBIN can be used in several different implementations, with a graphical user interface, or as a
stand-alone calculation kernel. This document is a user guide for LYBIN 7.0 which is a stand-
alone executable application with a graphical user interface wrapped around the calculation

kernel.

The main difference in LYBIN 7.0 compared to previous releases is the new functionality to find
the best sonar parameters. A new editor for predicted sonar range (PSR) is also added.
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Sammendrag

Den akustiske stralegangsmodellen LYBIN er en etablert og mye brukt sonarytelsesmodell som
eies av Forsvarsmateriell (FMA). Modellen brukes ombord pa marinefartgy og i
treningssituasjoner pa land. LYBIN er blitt et viktig verktgy bade i planlegging og evaluering av
maritime operasjoner. Tidligere versjoner er allerede integrert i programvare for kampsystemer,
beslutningsstatte og taktiske trenere.

LYBIN kan brukes i flere forskjellige utfgrelser, med et grafisk brukergrensesnitt, eller som en
frittstdende beregningskjerne. Dette dokumentet er en brukermanual for LYBIN 7.0 som er en
frittstdende programvare med et grafisk brukergrensesnitt liggende utenpa beregningskjernen.

Hovedforskjellen mellom LYBIN 7.0 sammenliknet med tidligere versjoner, er den nye

funksjonaliteten for & finne de beste sonar parameterne. Det er ogsé lagt til en ny
redigeringsmodul for beregnet sonarytelse.
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1 Introduction

LYBIN [1], [2] is a well established and frequently used sonar prediction tool owned by the
Norwegian Defence Materiel Agency (NDMA) and FFL. It is in operative use by the Norwegian
Navy and in a number of other nations, and has been modified and improved for this purpose for
more than 30 years. FFI has been responsible for testing, evaluation and development of LYBIN
since 2000 and has been responsible for commercial sale and support since 2009.

LYBIN is a robust, user friendly and fast acoustic ray-trace simulator. A broad set of parameters
is used to accurately calculate the probability of detecting objects in a given area under water
with the use of sonar technology. As this probability changes with environmental properties,
LYBIN rapidly calculates the sonar coverage.

Several thousand acoustic rays are simulated traversing the water volume. Upon hitting the sea
surface and sea bed, the rays are reflected and exposed to loss mechanisms. Losses in the water
volume itself, due to thermal absorption are accounted for. LYBIN estimates the probability of
detection for a given target, based on target echo strength, the calculated transmission loss,

reverberation and noise. Both active and passive sonar systems can be simulated.

LYBIN can be used both with a graphical user interface and as a stand-alone calculation
kernel. This duality enables LYBIN to interact with other applications, such as mathematical
models, web services, geographic information systems, and more. The software is integrated in
combat system software, tactical decision aids and tactical trainers. LYBIN has become an
important tool in both planning and evaluation of maritime operations [3],[4].

The stand-alone calculation kernel, called LybinCore is available in two different wrappings;
LybinCom and LybinTCPserver. LybinCom [5] is implemented as a Microsoft COM [6]
module for the Windows platform. LybinTCPserver is based on Apache Thrift [7], using
TCP/IP remote procedure calls. LybinTCPserver can be built for both Windows and Linux
platforms.

This document describes the installation and use of the software LYBIN 7.0. It includes
LybinCom and a graphical user interface (GUI) built together to make a stand-alone executable
application. In the following chapters, we call this software LYBIN.

This document is an updated version based on earlier released user guides. The main difference

between LYBIN 7.0 and the previous release LYBIN 6.2 2200 [8], is the new editor for
calculation of the best sonar parameters and the new editor for predicted sonar range.

FFI-RAPPORT 24/00023 7



The hardware and software requirements for LYBIN 7.0 are given in Chapter 2 together with
detailed installation instructions. Chapter 3 describes how to start and close LYBIN 7.0. The
menu and toolbar options are briefly described in Chapter 4. The various plots are presented in
Chapter 5 before a more thorough description of parameter input via the panes and editors are
given in Chapter 6 to 8. Tactical decisions aid tools are described in Chapter 9. At last, Chapter
10 describes printing. Examples of XML LYBIN input data are included in Appendix A.

2 Hardware requirements, software requirements
and installation

This section describes the requirements for installing LYBIN 7.0, and the process of actually
installing the software.

21 Hardware requirements

This section describes the minimum hardware requirements for running LYBIN 7.0 with
satisfactory user interaction responsiveness.

The minimum hardware requirements are based on the hardware requirements of the software
requirements, described in the next section.

e 1 GHz CPU or higher
e 512MB RAM or higher
o 10 MB free disk space

2.2 Software requirements

All required software, not included in the operating system by default, is listed under software
requirements.

e Operating system: Microsoft Windows XP SP3 or newer.
e Microsoft NET 3.5 Framework
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LYBIN 7.0 is built for 64-bit Windows operating systems. The LybinCom-module can also be
used by other 3" party software on a 64-bit Windows platform.

LYBIN 7.0 is shipped as an installation file:

e LybinSetup.msi
o Contains the LYBIN software.
o Can be installed only if all prerequisites are met.

Double-clicking on the file starts an installation wizard which will lead you through the
installation of LYBIN 7.0.

3 Getting started with LYBIN

Start LYBIN from the shortcut placed in the Program section of the Start menu:
Start --> All Programs --> FFl Applications --> Lybin
The initial view when entering LYBIN is displayed in Figure 3.1.

When LYBIN is started, a set of default input parameters is loaded. This can be edited before

the plots are computed, but a calculation can also be started immediately by clicking ! or F5.
When parameters have been modified, a calculation has to be started to generate new plots.

The parameters can either be stored in an XML file containing all input parameters (described in
Appendix A) or stored in dedicated XML files for each editor (described in Chapter 8).

To quit LYBIN, select Exit from the File menu or click the #3588 button in the screen’s
upper right corner.

A file with the current parameter setting is stored under the current user:

e Windows XP:
C:\Documents and Settings\<user>\Local Settings\Application Data\FFI
e Windows Vista and newer: C:\Users\<user>\AppData\Local\FFI
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W, Lybin 7.0

File Edit View Plot Help
e o T g o | RV e Bt | Y[ | BRI (| Most recentplot - 1 of 1 2
{ Settings | Environment Plot Raytrace  Transmission Loss  Probability of Detection  Signal Excess  Reverberation Curves
Sonar  Ocean & Target Model Parameters  Display 1 3 3 N 5 6 1 g o i
o
Sonar | Sanarl v [ Customize
[ Use Passive Mode
Calib. Factor [d8] 0.0 System Loss [dB] (e 0 - . . . o o . . .
Detect. Thresh. [dB] 1001 Trans. Depth [m] 80,015
Transmitter/Receiver seftings 10 . . . . " " . . o
Transmitter Receiver
Titt Angle [deg): 00 00}
Beam Width [degl: 15.0[% 150% 150 s s s s s s 2 s s
Side Lobe [dB]: 13.0 1305
Active sonar settings 00 * * * * * * * * *
Mode: | defauttmods = Pulse: |FM,B0ms  ~ Pulse Fom
Frequency [Hzl 7000  ~ Envelope Funct Pulse Length fms] 60.0= 250 . . . . . . . . .
Source Level [dB]: 221015 Fiter Bandwidth [Hz] 100015
Directivty Ind. [dB] 20012]  FM Bandwidth [Hz] 1000/
300
:
Raytrace Transmission Loss  Probabity of Detection Signal Excess  Reverberation Curves Raytrace Transmission Loss ~Probability of Detection ' Signal Excess Reverberation Curves
m m
. .
300 300
o 40 45 30 55 &0 65 0 75 80 85 80 85 [dE] n 95 80 75 S0 25 10 2 [#]
Figure 3.1 The initial view when LYBIN is started. There are four panes: one settings pane

on the upper left, and the other three will display calculation results of choice.

4 The main screen

When LYBIN is started, the multi-pane main screen appears (see Figure 3.1). This screen is
divided into four panes: one pane for input parameters at the upper left, and three panes
dedicated to display the various result types. A main menu and a toolbar with icons pointing to
functionality are located in the top of the screen. Figure 4.7 gives a schematic view of the initial
main screen.

An alternative main screen is the single pane view. This view shows only one plot at a time, and
has an area for input above the plotting area.
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Both the multi-pane view and single pane view main screen share the main menu and a common
toolbar, and provide the same functionality. The single pane view mode is displayed in Figure
4.2. To access the single pane view pane click

View --> Single Pane View
or click the icon !E .
To return to multi-pane view click

View --> Multipane View

or click the icon !E .

LYBIN

Main menu
Toolbar
Settings | Environment Plot Plotype 1 | Plotype 2 | Plotype n...
Parameter entry Display plot
Plotype 1 | Plotype 2 | Plotype n... Plotype 1 | Plotype 2 | Plotype n...

Display plot
il Display plot

Figure 4.1 A schematic view of the LYBIN main screen.
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W, Lybin 7.0
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Figure 4.2

4.1 The Main Menu

The single pane view in LYBIN where only one calculation result is displayed.

This section gives an overview of the functions that can be accessed from the Main menu.
References are given to later chapters where functionality needs further explanation.

The Main menu contains the following functions:

File

e  Print — prints the upper right plot using the selected printer. Refer to chapter 10 for

more information.

e Print preview — shows the upper right plot as it will appear when printed. Refer to

chapter 10 for more information.
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Edit

View

Load data model — loads a previously saved complete data model in XML format.
Save data model — saves the active data model in an XML format.

Exit — closes LYBIN.

Environment — opens the Environment Editor. See section 8.1 for more information.
Wind Speed — opens the Wind Speed Editor. See section 8.2 for more information.
Sound Speed — opens the Sound Speed Editor. See section 8.3 for more information.

Volume Backscatter — opens the Volume backscattering Editor. See section 8.4 for more
information.

Bottom Profile — opens the Bottom profile Editor. See section 8.4 for more information.
Bottom Type — opens the Bottom Type Editor. See section 8.5 for more information.

Bottom Backscatter — opens the Bottom back scattering Editor. See section 0 for more
information.

Bottom Loss — opens the Bottom Loss Editor. See section 8.6 for more information.

Reverberation and noise — opens the Reverberation and noise Editor. See section 8.7 for
more information.

Ship, Sonars & Self Noise — opens the Sonar and ship-noise Editor. See section 7.1 for
more information.

Multipane View — displays the multi-pane view.
Single Pane View — displays the single pane view.

History All Modes — displays the plot history for all plot types. This display is described
further in section 5.7.
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Plot

o Compute Plots — computes all plots using the current set of parameter values. Chapter 5
describes the plots in detail.

e (Clear Bottom - clears the existing bottom topography and sets the bottom horizontal,
with a depth equal to the default value of 280 m.

Help

e About Lybin — displays a window with information about the current version of LYBIN.

4.2 The Toolbar

The toolbar contains icons that are shortcuts to important functions in LYBIN. The icons are
shortcuts to the following functions:

wiolk-8

=®  Sonarand Ship-noise Editor st Volume Back Scattering Editor
EE
. Environment Editor = Bottom Back Scattering Editor
L ~ad
=a  \Wind Speed Editor » Target Strength Editor
|—T Sound Speed Editor ! Compute Plots
1
sl Bottom Profile Editor Find the best sonar parameters
= Clear Bottom !E Toggle between single and multi view
rin  Bottom Type Editor IE View History
T 4
L Bottom Loss Editor == Predicted Sonar Range

REY Reverberation and Noise Editor
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In addition, the toolbar contains an option to choose between previous plots. A scenario where a
user has plotted five plots is displayed in Figure 4.3. The list box to the left gives an option to
select a plot directly while the user can step through the plots by clicking on the buttons to the
right.

Most recent plot S TS EE B of 5
Most recent plot

“2nd most recent plot
3rd rnost recent plot

" 4th most recent plot
5th rnost recent plot

Figure 4.3 Option to choose between previous plots.

4.3 The parameter pane

In multi-pane view mode, the most frequently changed sonar parameters for the acoustic model
are displayed in the upper left quadrant of the main screen (see Figure 4.4). Ocean and target
parameters, model parameters and display parameters are accessible by selecting one of the
other tabs inside the quadrant. In single pane view mode the sonar parameters are put in fields
above the plotting area. The other tabs are also accessible from this view mode. Chapter 6 gives
a description of all parameters available in the settings pane.

Sonar parameters not present here can be altered via the editor for Sonar Self Noise. This editor
can be accessed by selecting the Sonar and Ship-noise Editor alternative from the Edit menu

or by clicking the = icon. Section 7.1 gives a thorough description of how to set parameters
in this editor.

Shaded or grey input fields indicate that these fields are not valid for input in the set context.
White input fields indicate that these fields are valid for input. Yellow input fields indicate that
the field is still in editing mode and the return key or the tab key has to be pressed to update the
value, see Figure 4.5.

When a parameter has been modified, the compute button must be clicked or Compute Plots
selected from the Plot menu, to generate a new plot. Note that changes made to the sonar
parameters without computing plots, are not saved and loaded the next time the program is
started, if the parameter Customize is checked. If the same data is to be used in later program
runs, the Sonar Editor must be used to store the sonar description in a file (see Section 7.1 for
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more information). An alternative is to save the data model using Save Data Model from the
File menu.

The settings pane can be changed to display the environment plot, see Figure 4.6. This plot
visualises the environment parameters in the same way as they are interpolated in LybinCom.
The environment parameters can be set in the Environment Editor described in section 7.1.

Sonar  (cean & Target Model Parameters  Display

Sonar: | Sonarl L [ customize
[] Use Passive Mode

Calib. Factar [dB]: 0.0f= System Loss [dB]: 0.01=
Detect. Thresh. [dB]: 0.0 Trans. Depth [m]: 80.0=
Transmitter/Receiver settings

Transmitter Receiver

Titt Angle [deg]: 0.0k 0.0
Beam Width [deq]: 15.0/= 150

Side Lobe [dB]: 13.0/= 130

Active sonar settings

Mode: | defautmode e Pulse: |FM, 60ms Pulse Form:
Frequency [Hz]: | 7000 w Envelope Funct.: Pulse Length [mz]: &0.0=

Source Level [dB]: 22101% Fiter Bandwidth [Hz]: 1000
Directivity Ind. [dE]: 200/=]  FM Bandwidth [Hz]: 100,01
Figure 4.4 The upper left Sonar parameters tab. This is an easy access to the most

commonly changed parameters.

Model Scales
Range: 10000 =
Depth: 250 =

Figure 4.5 Input boxes turn yellow while editing. When the background returns to white,
the change is accepted.
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Environmert Plot

1505

1500

1425

1490

1453

1420

1475

1470

fmis]

Figure 4.6 The environment plot accessed from the main screen. This plot displays the
range dependent environmental properties. On top, the wave height is
illustrated as blue waves. The colouring illustrates the sound velocity, along the
profiles drawn with 1 km steps. The bottom profile is coloured by bottom type.
Moving the mouse pointer over any of the colourings will reveal the values of
the underlying data.

4.4 Plotting

The computation of plots is controlled by the Compute Plots item on the Plot menu or the icon

on the toolbar ! . All available plots, i.e. ray trace, transmission loss, probability of detection,
signal excess and reverberation curves, are computed each time a computation is selected. The
three plot panes can be used to display any of these calculated plots.

The history can be scrolled through by clicking on the arrow buttons in the toolbar, see Figure
4.3. All parameters that were used to compute the currently displayed plot are restored. In this
way, the parameters can be retrieved for a specific case, and editing on these parameters
continued. To display an overview of the last plots generated, click

View --> History All Modes

Section 5.7 describes the History All Modes display, and chapter 5 describes the various plots in
detail.
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4.5 Use of context menus and tooltips throughout the application

Context menus are used throughout the application. These menus are displayed when an object
is right-clicked. All plots can be copied by right-clicking on a plot and selecting “Copy to
Clipboard”. All input boxes gives context menus with various options for editing.

All input parameters have a tooltip with information about the parameter. The tool tip is

displayed when the mouse cursor hovers over the input box, without clicking on it, as seen in
Figure 4.7.

Customize

Use Passive Mode Transducer Depth - depth to which the sonar has been lowered.
System Loss [dB]: For some sonars the transducer depth is fixed while it can be adjusted for others,

Trans. Depth [m]: L=

Figure 4.7 The mouse cursor hovers over the transducer depth input box, and a tooltip with
information about the parameter appears.

5 Description of the various plots

This chapter describes how to interpret the plots.

5.1 Ray trace

The ray trace diagram illustrates how the sound propagates from the source. Only rays initiated
within the sonar main lobe is shown. In order to demonstrate typical ray paths, the scattering at
the sea surface is disregarded. An example of a ray trace diagram is shown in Figure 5.1.
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Raytrace | Transmission Loss | Probability of Detection | Signal Excess | Reverberation Curves

Figure 5.1 The ray trace plot displays a defined number of the sound's travel paths. These
paths are calculated based on the given sonar parameters and the environment
data.

5.2 Transmission Loss

The transmission loss plot graphically illustrates the loss of intensity the sound suffers as it
travels within the area spanned by the range and depth axes. Figure 5.2 gives an example of a
transmission loss plot.

Transmission loss may be considered to be the sum of the loss due to spreading and the loss
due to attenuation. Spreading loss is a geometrical effect representing the weakening of a sound
signal as it spreads outwards from the source. Attenuation loss includes the effects of absorption
and scattering. The estimation of the transmission loss is based on intensity computations for a
user-defined number of rays.

To read the plot, use the colour coding. To determine the transmission loss at an arbitrary

position in the plot, search for the colour of that location in the colour coding. The value of the
intensity loss (dB) is written above this colour.
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Raytrace | Transmission Loss | Probabilty of Detection | Signal Excess | Reverberstion Curves

Figure 5.2 The transmission loss plot displays the loss of intensity due to spreading and
attenuation in a cross-section of the water volume.

Here is a brief overview of the loss mechanisms LYBIN takes into account:

Cylindrical spreading - the intensity loss of a ray segment depends on the horizontal distance
travelled by the ray from the source.

Vertical spreading - given by the vertical density of rays.

Bubble attenuation - wind and breaking waves create a layer of air bubbles near the sea
surface. Sound rays passing through this layer suffer an energy loss depending on the incoming
angle. Small grazing angles imply lengthy paths through the bubble layer and hence greater
losses. The attenuation of the sound is strongly frequency dependent: negligible at low
frequencies, but significant close to the bubble resonance frequency around 55 kHz.

Bottom loss - is estimated using empirical data for a set of predefined bottom types. Refer to
8.5 for how to set the bottom type. The loss is a function of bottom type and grazing angle.
Predefined angles and corresponding losses are stored in LYBIN. The bottom loss can also be
given directly to LYBIN as an input parameter, as described in 8.6.

Thermal absorption - conversion of the elastic energy of a sound wave into heat. This results

in a heating up of the medium. Takes into account boric acid relaxation, magnesium sulphate
relaxation and viscosity.
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Scattering — not by itself a loss mechanism, but the results of scattering can be measured as loss
of energy. Unlike several other models which treat scattering as a loss, LYBIN attempts to
simulate the scattering process itself. When a sound ray hits the surface, it is reflected. Due to
ocean waves, the reflection is not necessarily specular. Scattering refers to the fact that the
reflection angle is somewhat random.

53 Reverberation Curves

The reverberation curves plot graphically illustrates the calculated reverberation from the sea
surface, the water volume, and the sea bottom. The total noise level, calculated from ambient
and self noise, is also included in the plot. Total reverberation is the sum of all the reverberation
from the surface, volume and bottom. The masking level is the sum of all reverberation and
noise present.

Both the reverberation and noise are plotted in dB re pPa as a function of distance from the
sonar. Noise is shown in green, the surface reverberation in blue, the volume reverberation in
orange, the bottom reverberation in brown, the total reverberation in black and the total masking
level is shown in magenta. Figure 5.3 gives an example of the reverberation curves plot.

To read the plot, use the colour coding. To determine the reverberation at an arbitrary distance
in the plot, find the distance and locate the curve of interest. The value of the reverberation (dB
re uPa) is read from the axis to the left.

Reverberation and noise levels are estimated differently for the CW (continuous wave) and FM
(frequency modulated) pulses; see section 6.1.1 for more details on the two available pulse
types. The difference lies in the processing gains. In the case of an FM pulse the reverberation
and noise levels are reduced by 10logio(BT), where B is the frequency bandwidth and T is the
pulse length, see section 6.1.1. The CW pulses are estimated according to reverberation zone;
see section 6.2.1 for more information about the different zones.

5.4 Signal Excess

The signal excess plot graphically illustrates the estimated signal level for a target at any range
and depth in the calculated area. The signal excess is calculated on the basis of target echo
strength, detection threshold, calculated transmission loss, reverberation and noise. An example
of a signal excess plot is shown in Figure 5.4.

To read the plot, use the colour coding. To determine the signal excess for an arbitrary position

in the plot, search for the colour of that location in the colour coding. The value of the signal
excess (dB) is written above this colour.
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‘ Raytrace I Transmission Loss I Probability of Detection | Signal Excess | Reverberation Cunres‘

Figure 5.3 The signal excess plot displays the remaining part of the signal, after target
strength is added and transmission loss, reverberation, noise and detection
threshold are subtracted, in a cross-section of the water volume.

Raytrace | Transmission Loss I Probability of Detection | Signal Exr.essl Reverberation Curves |

Im
0 1 2 3 4 3 L] 7 Ll E 10

100 + + + + + + + + +

dE/1 uPa . :
Hoise Vobme Surfce Eottom. Total rewerberatioz Ik lewel

Figure 5.4 The reverberation curves plot displays the calculated reverberation from the
sea surface (blue), the water volume (orange) and the sea bottom (brown). The
total reverberation is seen as the black line. The total noise level (green),
calculated from ambient and self noise, is also included in the plot. The total of
noise and reverberation is included as the masking level (magenta).
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5.5 Probability of detection

The probability of detection plot graphically illustrates the probability of finding an object with
a given target strength within the area spanned by the range and depth axes. Figure 5.5 gives an
example of a probability of detection plot.

The estimation of probability of detection is based on the results from the transmission loss,
noise and reverberation estimation. The sonar equation is used to calculate the signal excess,
and the probability of detection is derived accordingly.

To read the plot, use the colour coding. To determine the probability of detection at an arbitrary
position in the plot, search for the colour of that location in the colour coding. The value of the
probability of detection (%) is written above this colour.

Raytrace | Transmission Loss | Probability of Detection | Signal Excess | Reverberation CLINES‘

Figure 5.5 The probability of detection plot displays the probability of detecting a target
with a given echo strength under the given sonar and environmental conditions.
It is assumed a 50 % probability of detection at a signal excess of 0 dB.

5.6 Environment plot

The environment plot will give the user an overview of the environment parameters as they are
interpolated and used in the calculations. The plot is placed next to the settings tab in the main
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screen. The Environment Editor, described in section 6.1, displays the same plot but the
parameters there are not interpolated. In addition, the Environment Editor gives access to all
environmental parameter editors. Figure 5.6 gives an example of the Environment plot.

The environment plot shows all the environment parameters as they are interpolated and used in
the calculations. At the top of the plot, waves illustrate the given wind speed or wave height.
The height of each wave corresponds to the value at that range. The sound speed is graphically
illustrated with colour codes in the water volume. Red indicates hot water and high sound speed,
while blue represents cold water, and thus low sound speed. The bottom topography is shown at
the bottom of the plot with different shadings in grey indicating sediment type.

The actual value at each range and depth can be found by holding the mouse cursor over the

environment plot. The position and parameter value are then displayed below the plot, as shown
for the sound speed at range 5605 m and depth 186 m in Figure 5.6.

Environment Plot

1505

1500
100
1495

1490
150
1435

1420

200

1475

1470

as0

k]

300
m

Range [m]: 5605 Depth [rm]: 186 Sound Speed [m/s]: 14598.9

Figure 5.6 The environment plot displays the range dependent environmental properties.
On the top, the wave height is illustrated as blue waves. The colouring
illustrates the sound velocity, along with the profiles drawn with 1 km steps. The
bottom profile is coloured by bottom type. Moving the mouse pointer over any
of the colourings will reveal the values of the underlying data.
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5.7 Plot History
To display an overview of the last plots generated, click
View --> History All Modes

or click the icon IE .

An example with plots for the last 6 calculations is displayed in Figure 5.7.

ananan wt

VAN

Figure 5.7 The history window displays a selected number of previously calculated results.
Which results to display may be changed by the user. The figure displays a
screen-shot where the user has chosen to display all results and the
environment for the last six calculations.

There are control parameters located at the bottom of the screen:
e To remove the index number to the left, uncheck the checkbox Index.
e To remove the ray trace plots, uncheck the checkbox Rays.

e To remove the transmission loss plots, uncheck the checkbox 77. Loss.
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o To remove the signal excess plots, uncheck the checkbox Sig. Exc.

e To remove the probability of detection plots, uncheck the checkbox P.o.D.

e To remove the reverberation curves plots, uncheck the checkbox Rev.

e To remove the environment plots, uncheck the checkbox Env.

e To control how many plot calculations to be displayed, select the desired value from the
listbox Plots per screen. The value Fit A/l will find the best fit for all calculations

performed in a window.

e If there are more calculations performed than displayed on the screen, the checkbox
Continue off-screen can be checked to enable scroll-down functionality.

To go back to the main screen, click
View --> Multipane view/Single Pane view

or click the icon !E

6 Entering parameters from the main screen

This chapter describes the parameters available from the Settings tab on the main screen. For
more detailed description of the parameters and their effects on sonar performance, please refer
to [9].

6.1 Sonar settings
The sonar parameters available for both active and passive sonar are:

e Sonar - name of the current sonar. The list of available sonars is displayed by clicking
on the arrow down button to the right. By default, only the default sonar is available.
New sonars can be added either by using the Sonar Self Noise editor described in
section 7.1 or by importing a data model using the option in the File menu.

26 FFI-RAPPORT 24/00023



o  Customize — allows the user to quickly set up a customized sonar. When checked, all
sonar parameters displayed here are open for input.

e  Use Passive Mode — lets LYBIN run computations for passive sonar. When checked,
fields for passive sonar are displayed (see Figure 6.2). The Transmitter part of the
Transmitter/Receiver settings is also locked for input when Use Passive Mode is
checked.

e Calibration Factor — this parameter is a calibration factor that is not yet implemented
but is displayed on the GUI for future use.

e Detection Threshold — the strength of the signal relative to the masking level necessary
to see an object with the sonar. The threshold can range from -100 dB to 100 dB.

Sonar | Ocean & Target | Model Parameters I Displa'_.r|

Sonar:  Custom sonar Customize
[] Use Passive Mode

Calib. Factor [dB]: 0.0= System Loss [dB]: 0.0=
Detect. Thresh. [dB]: 10,0 Trans. Depth [m]: L=
Transmitter/Receiver settings

Transmitter Receiver

Titt Angle [deg]: 40 40
Beam Width [deg]: 17.00= 17.0/=

Side Lobe [dE]: 11.0/= 1.0

Active sonar settings

defaultmode CW, 44ms Pulse Form:

Frequency [Hz]: 6000 = Envelope Funct : Pulse Length [ms]: 44 0=
Source Level [dB]: 222 01= Fiter Bandwidth [Hz]: 59,0 =
Directivity Ind. [dB]: 20 FM Bandwidth [Hz]: 100,01
Figure 6.1 The sonar settings available for active sonar contain the most commonly

changed parameters for active sonar. If the sonar is specified with all available
modes, the modes can be selected in the "Mode" selection box. If that is not the
case, the user may check the "Customize" box to freely change any parameters

of choice.
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System Loss - system loss due to special loss mechanisms in the sea or sonar system not
otherwise accounted for.

Trans. Depth - depth to which the sonar has been lowered. For some sonars the
transducer depth is fixed while it can be adjusted for others. The parameters describing
whether the depth is fixed or in which depth range the sonar is to operate are set in the
Sonar Editor described in section 7.3. The field for transducer depth available from the
main screen is therefore dependent on these parameters. The transducer depth ranges
from 0.1 to 12,000 meters.

Tilt Angle Transmitter - current angle of the transmitting part of the sonar beam centre,
measured from the horizontal. Positive degrees go upwards and negative downwards
from 90 to -90 degrees. The parameters describing whether the tilt is fixed or in which
tilt range the sonar is to operate are set in the Sonar Editor described in section 7.3. The
field for Tilt Angle available from the main screen is therefore dependent on these
parameters.

Tilt Angle Receiver - current angle of the receiving part of the sonar beam centre,
measured from the horizontal. Positive degrees go upwards and negative downwards
from 90 to -90 degrees. The parameters describing whether the tilt is fixed or in which
tilt range the sonar is to operate are set in the Sonar Editor described in section 7.3. The
field for Tilt Angle available from the main screen is therefore dependent on these
parameters.

Beam Width Transmitter - vertical opening of the beam of the transmitting part of the
sonar. There is a higher concentration of rays within the beam width, in the direction
around the tilt angle. The beam width can range from 1-360 degrees.

Beam Width Receiver - vertical opening of the beam of the receiving part of the sonar.
There is a higher concentration of rays within the beam width, in the direction around
the tilt angle. The beam width can range from 1-360 degrees.

Side Lobe Transmitter - difference in intensity levels (in dB) between the main lobe and
the first side lobes, from 5 to 43 dB. This parameter indicates the suppression of the first
side lobe of the transmitting part of the sonar relative to the centre of the beam. High
figures give one-beam-only sonars, whereas low figures give visible side lobes.

Side Lobe Receiver - difference in intensity levels (in dB) between the main lobe and
the first side lobes, from 5 to 43 dB. This parameter indicates the suppression of the first
side lobe of the receiving part of the sonar relative to the centre of the beam. High
figures give one-beam-only sonars, whereas low figures give visible side lobes.
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6.1.1 Parameters specific to active sonar

The following parameters are available when Use Passive Mode is unchecked, i.e. for active
sonar:

e Mode - name of the current sonar mode. A list of available modes is available by
clicking on the arrow down button to the right of the field. By default, only the default
mode is available. New modes can be added by using the Sonar Self Noise editor
described in section 7.1 or by importing a complete data model.

e Frequency - operating centre frequency of the sonar. The frequency can range from 200
Hz to 1 000 000 Hz.

o  Source Level - the source level of the sonar with the currently selected mode and
frequency. The source level (in dB) is the output volume of the sonar, and must be in
the range 0 — 500 dB.

e Directivity Index - the sonar’s ability to suppress isotropic noise relative to the response
in the steering direction. The directivity index can range from -100 dB to 100 dB.

e Pulse - a field describing the pulse form and length for the defined mode.

e Envelope Function - envelope function of the signal. Currently, only “Hann” is
available.

o  Filter Bandwidth — the filter bandwidth of the pulse. The Filter Bandwidth ranges from
0 to 10 000 Hz.

o FM Bandwidth — frequency modulation bandwidth of the pulse. Applicable for FM
signals only. The FM Bandwidth ranges from 0 to 10 000 Hz.

e Pulse Form - the pulse form of the currently selected pulse. A list of available pulse
forms is available by clicking on the arrow down button to the right of the field. Valid
values are FM (frequency modulated) and CW (continuous wave).

o  Pulse Length - the length (in ms) of the currently selected pulse. Valid pulse lengths are
from 0 to 30 000 ms.

6.1.2 Parameters specific to passive sonar

LYBIN can perform calculations also for passive sonar. When the checkbox Use Passive Mode
is checked, passive sonar setting is displayed. The sonar parameters available for passive sonar
only are:
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Type — describes whether the sonar is broad or narrowband. Both choices are available
by clicking on the arrow down button to the right of the field.

Bandwidth — bandwidth for the passive sonar. The Bandwidth ranges from 0 to 10000
Hz.

Frequency — centre frequency for the passive sonar.

Integration Time — integration time for the passive sonar. The valid values range from
0,001 ms to 100 s.

Calculate Processing Gain — when checked LYBIN calculates passive processing gain

according to given sonar type, bandwidth, directivity index and integration time.

e Set Processing Gain — when checked it allows the user to set the passive processing

gain directly.

e ProcessingGain — the value (in dB) of the processing gain, either set by the user or

calculated by LYBIN.

Sonar | Ocean &Targe‘tl Model Parameters I Displaf|

Sonar:  Custom sonar

Transmitter/Receiver settings

Passive Sonar Settings

Calib. Factar [dB]: 0.0k
Detect. Thresh. [dE]: 10,0

Tilt Angle [deq]: 4,
Beam Width [deq]: 17

Side Lobe [dE]: 11.01=

Type: [Narrow-band

Bandwidth [Hz]: 100,01
Frequency [Hz]: 800,01
Integration Time[s]: 1.0

Customize
lUse Passive Mode

System Loss [dE]: 0,0
Trans. Depth [m]: =

Receiver
40=
170=

1.0

@ Calculate Processing Gain
(") Set Processing Gain

ProcessingGain [dB]: 0.0

Figure 6.2 The sonar settings available for passive sonar contain the most commonly changed
parameters for passive sonar. The user can check the "Customize" box to freely
change any parameters of choice.
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6.2 Ocean and Target

LYBIN provides an option to set various ocean and target parameters prior to calculation as
shown in Figure 6.3.

6.2.1 Setting target parameters
The ocean and target parameters available are:
e Target Strength — echo which is returned from the target. A value of -15 means that the
intensity reflected from this particular target is 15 dB less than the incoming signal.
This parameter is used in the sonar equation for active sonars.

o Aspect Angle — The aspect angle of the target, seen from the sonar platform.

e Source Level — this is the source level of the target. This parameter is only used in
calculations for passive sonars.

e Reverberation Zone — the zone that the target is within, relative to the ship. The are
three reverberation zones:

o Main lobe - represents the case where the target is within the main lobe of the
sonar, and the targets Doppler speed is lower than the ships own speed.

o Typical — Typical horizontal side lobe suppression, where the target’s Doppler
speed is lower than the ship’s own speed.

o No reverb - The Doppler speed of the target is equal or higher than the ship’s
own speed, so the scenario becomes noise limited.

6.2.2 Manipulating the water parameters

e pH—pH level in the sea water.
o Default salinity [ppt]- Default value for the salinity in the water can be set here. The

parameter is to be used when the sound speed and temperature profiles available do not
have any salinity measurements.
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Target

Reverberation Zone:

Platform / Own Ship

MName:

Strength [dB]:
Aspect Angle [dea]:
Source Level [dB]:

Self Naoise [dB]:
Self Moise Passive [dB]:
Ship Speed [knots]:

1502
0.0
150,0/%

50,002
50,002
100

Water

pH:

Default salinity [ppt]:

Miscellansous

Ship Density:
Precipitation Moise Type:
Ambient Moise Level [dB]:

Use Suface Scattering:

3.0
35.0=

4.0

RO.0 B

Figure 6.3

6.2.3

Inspecting platform parameters

The ocean and target parameters available for editing.

The parameters in the Platform / Own Ship group box are not editable. They only reflect the

parameter settings in the Sonar Self Noise editor described in section 7.1.

e Name — Name of the ship

e Self Noise - The ship’s in beam and in band self noise in the direction of the current

simulation.

o Self Noise Passive — The ship’s in beam and in band self noise in the direction of the
current simulation. This parameter is used in calculations for passive sonar.

e  Ship Speed — The current ship speed in knots.
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6.2.4 Manipulating the miscellaneous parameters

e Ship Density - Density of ship traffic in the area of the calculation. The ship density can
vary from 1 (low) to 7 (high).

e Precipitation Noise Type— type of precipitation in the area. The valid values are:

None

Light Rain
Heavy Rain
Hail

Snow

o 0O 0O O O

e  Ambient Noise Level —noise from ambient sources. If the corresponding check box is
checked, this parameter will override the internal calculation of ambient noise by
LYBIN.

o  Use Surface Scattering — If checked, the rays hitting the sea surface will be reflected in
a manner simulating sea scattering. The amount of scattering depends on the given
frequency, the sound speed at the surface and the wind speed. If not checked, the rays
hitting the sea surface will be reflected specularly as from a perfectly smooth surface.

6.3 Model Parameters

LYBIN provides an option to set various model parameters prior to calculation, as seen in
Figure 6.4.

o Signal Excess Constant — This parameter can be used to adjust the relation between
signal excess and probability of detection. At the moment, this parameter is not editable
in LYBIN.

6.3.1 Setting range and depth resolution

The calculation resolution is controlled by the parameters described in this section. The range
and depth scales set here mark the border around the calculation. The calculation results are
divided into calculation cells, and are the basis of the graphical plots in LYBIN.

The internal ray tracing is based on an additional detailing level, called steps. As default, the

number of range steps is 10 times the number of range cells, and the number of depth steps is 20
times the number of depth cells. To avoid too large steps, there is a maximum range step size of
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50 meters, and a maximum depth step size of 5 meters. If this step size is exceeded, additional
range steps are added.

Range Scale/Resolution Transmizgsion Loss Rays
Free Parameters
Scale [m]: 10 000,0= _ Mumber of Rays: h 0D =
@ Scale and #Cells
. & . Ennn | =
#Cells: = “ Scale and Call Size Max Border Hits: 5000 =
Cell Size [m]: 200,0= ) Scals and # Steps Temination Intensity: 0.0
# Steps: 500 = () Cell Size and # Steps Signal Excess Constart: 3.0
Depth Scale/Resolution Visual Rays
Free Parameters
Scale [m]: 250.0= _ Mumber of Rays: h =
@ Scale and # Cells
#Cells: = ) Scale and Cell Size Mz Surface Hits: 2=
Cell Size [m]: = ) Scale and # Steps Mz Bottom Hits: 1=
# Steps: 000 = 1 Cell Size and # Steps Calculation Switches
Rev and noise calculation type:
Bottom types -
|se measured bottom loss: [E
Use measured target strength: [
Figure 6.4 The model parameters available. These parameters control the resolution of the

calculation. If the environmental data has high resolution, the resolution of the
calculations may be increased.

The following parameters are available to control range and depth resolution:
e Scale — Maximum range or depth in the calculation area.
e # Cells — Number of calculation output cells in depth or range.
e C(Cell Size — Size of calculation output cell, given in meters.

o # Steps — Number of calculation steps to be used during the internal calculation in
LYBIN.

All these parameters cannot be set independently at the same time. The calculation resolution
would then be over-determined. The free parameters help you avoid this. Within each group box
of free parameters (one for range and one for depth), only one combination of parameters can be
chosen. Each alternative opens the corresponding resolution parameters for editing.
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The following combinations of resolution parameters can be set:
o Scale and # Cells — Maximum range/depth and a specific number of cells.
e Scale and Cell Size - Maximum range/depth and a specific cell size.
o Scale and # Steps - Maximum range/depth and a specific number of calculation steps.

o C(Cell Size and # Steps — A specific cell size and a specific number of calculation steps.

6.3.2 Manipulating transmission loss rays

The transmission loss rays are the rays that are used in the calculation of transmission loss, and
thereby form the basis of all the other calculation results in LYBIN. The transmission loss rays
are spread in all directions, according to a density pattern given by the sonar characteristics.
The parameters affecting the transmission loss rays are:

e Number of rays — Number of transmission loss rays.

e  Max border hits — Maximum allowed hits at each border, e.g. surface and sea bottom.
At the moment, this parameter is not editable in LYBIN.

o Termination Intensity — The lowest possible intensity a ray can have before it is
terminated. At the moment, this parameter is not editable in LYBIN.

6.3.3 Manipulating visual rays

The visual rays are the rays graphically displayed in the ray trace plot as seen in Figure 5.1.
These rays are meant to illustrate the rays with the most energy, thus only rays initiated within
the sonar main lobe are shown.
The following parameters are available to manipulate the visual rays:

e Number of Rays — Number of visual rays in the ray trace plot.

e  Max surface Hits — Maximum number of surface hits in the ray trace plot.

e  Max Bottom Hits — Maximum number of bottom hits in the ray trace plot.
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6.3.4 Using calculation switches

In situations where there are multiple choices of how to perform a calculation, or which sub-
model to use, these choices are made through calculation switches.

The calculation switches available are:

e Rev and noise calculation type — Control the calculation of bottom reverberation values.
There are four possible choices:

o Bottom types — Calculate bottom reverberation from bottom types.

o Bottom back scatter — Calculate bottom reverberation from backscatter values.
How to add Bottom backscatter data is described in section 8.9.

o Measured rev and noise — Use measured reverberation and noise data in stead
of calculation. How to include measured reverberation and noise is described in
section 8.7

o Lamberts law — Use Lamberts rule to calculate the bottom reverberation. This
choice is dependent of the LambertsCoefficient, which can only be set by
loading a complete data model as described in section 4.1.

o Use measured bottom loss — Tells LYBIN how to calculate bottom loss. If Use
measured bottom loss 1s checked, LYBIN will use measured bottom loss values. These
must be added as described in section 8.6. If Use measured bottom loss values is not
checked, LYBIN will calculate the bottom loss internally from the given (or default)
bottom type.

o Use measured target strength-Tells LYBIN which target strength to use. If Use

measured target strength is checked, LYBIN will use measured target strength values
as given in the Target Strength Table Editor.

6.4 Display

LYBIN provides an option to set various display parameters prior to calculation. The display
parameters control the colouring of plots, step sizes, axis properties and more. The display tab is
seen in Figure 6.5.

The following display parameters are available:

e Use — Controls whether each plot can have its own display parameters, or not. The two
choices are:
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o Global display options — Display parameters do not change from one simulation
to the next.

o Separate values per plot — Separate display parameters for each simulation.
o Transmission Loss Scale — Change plot colours between multiple colours and greyscale.

e Probability of Detection Scale - Change plot colours between multiple colours and
greyscale.

o Signal Excess Scale - Change plot colours between multiple colours and greyscale.

|Sunar I Ocean & Target | Model F‘alame‘ters| Display |

Use: [Sepalate values per plat v] Transmission Loss Scale:
Visible Area Prob. of Detection Scale:

Range [m]: 0= - 10000 = Signal Excess Scale:

Depth [m]: 0= - 300 (=

Signal Excess Scale [dE] Transmission Loss Scale [dE]
Mandimum: 40.0 = Minimum: 40,0 =
Step Size: bk Step Size: =

Reverberation Scale [dB]
Na - 129

Figure 6.5 The display parameters available. These parameters let the user alter the
presentation of the calculation results without altering the results themselves.
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6.4.1 Visible Area

The parameters in the Visible Area group box control the area displayed in the plots. This area
does not have to be the same as the calculation area. The parameters controlling the visible area
are:

e  Range — Minimum and maximum plot range.

e Depth — Minimum and maximum plot depth.

6.4.2 Signal Excess Scale

The parameters in the Signal Excess Scale group box control the Signal Excess plot as shown in
Figure 5.4. The parameters are:

o Maximum - Lowest value of the colour representing the highest signal excess.

e Step Size - Range in decibels for each colour.

6.4.3 Transmission Loss Scale

The parameters in the Transmission Loss Scale group box control the Transmission Loss plot as
shown in Figure 5.2. The parameters are:

o Minimum — Highest value of the colour representing the lowest transmission loss.

e Step Size - Range in decibels for each colour.

6.4.4 Reverberation Scale

The minimum and maximum values of the decibel values in the Reverberation Curves plot are
controlled in the Reverberation Scale group box. The lower value is given to the left and the
higher to the right. The Reverberation Curves plot is shown in Figure 5.3.
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7 Platform editors

The platform editors allows the user to edit all type of information connected to own platform
and sonar system.

71 Sonar Self Noise

The Sonar Self Noise window displays ship parameters given in the Ship Editor (see section
7.2) and the Sonar Editor (see section 7.3).

The Sonar Self Noise window can be invoked by selecting
Edit --> Ship, Sonars & Self Noise

or by clicking the =% icon on the toolbar. The window is shown in Figure 7.1.
The values seen this window — frequency, transducer depth, ship speed, and relative bearing —
affect the noise levels shown in the window. The values as is used in calculations can be set in
the Ship Editor, Sonar Editor, or Sonar Settings tab, as appropriate.
The following parameters are displayed in the Sonar Self Noise window:
Ship

e Name - the name of the ship.

e Type - type or class of ship, for instance “frigate”.

e Edit Ship button — opens the Ship Editor.

Sonar

e Sonar name — name or type of the sonar

Sonar Settings

e Frequency - the frequency (in kHz) for which the noise level is shown.

o  Transducer Depth - the transducer depth (in m) for which the noise level is shown.
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M. Sonar Self Noise

Ship Sonar

Mame: |Tesi ship | — defaultsonar b

Type: |A|_rtn generated | Edit Sonar
Sonar Settings

Self Noise [dB] Frequency [kHzl: 701
Transducer Depth [m]: 20k
Relative Bearing [deal: 45=

Cther parameters affecting Moise

270 Ship Speed [knots]: 10,0

Wind Speed [m/s]: 40
Ship density: 4=
Precipitation type:

Moise levels at sonar frequency

Ship Noise [dB]:

Shipspeed[knots] Ambient Noise [dE]:

10 11 11 12 12 13
Total Noise [dB]:

QK Cancel

Figure 7.1 The Sonar Self Noise window contains a graphical presentation of the ship self
noise. The window also contains buttons to open editors for the ship and sonar
parameters.

Other parameters affecting Noise

o Ship Speed - the ship speed, in knots, for which the noise level is shown.

e Relative bearing - the direction (relative to the ship) for which the noise level is shown.
Given in degrees.

o Wind Speed — wind speed in m/s.

o Ship density — density of ship traffic in the area of the calculation. The ship density can
vary from 1 (low) to 7 (high).
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e Precipitation type - type of precipitation in the area. The valid values are:

None

Light Rain
Heavy Rain
Hail

Snow

O O O O O

Noise levels at sonar frequency

e  Ship Noise — the ship’s in beam and in band self noise at the specified frequency,
transducer depth, speed, and relative bearing.

o Ambient noise — ambient noise from external sources.

e Total Noise — ship and ambient noise combined.

7.2 Ship editor

The ship editor contains all the relevant information about the platform holding the sonar. The
platform is most often a ship, but can also be a helicopter or a buoy.

The Ship Editor can be invoked by selecting the Edit Ship button in the Sonar Self Noise
window. The editor is shown in Figure 7.2.

Ship parameters include:
o Ship name - the name of the ship.
o  Ship Type - type or class of ship, for instance “frigate”.
e Course - the ship’s course, in degrees, relative to North.
e Speed - the ship’s current speed, in knots.
e Latitude- the ship’s current latitude, in decimal degrees. North is defined positive.

e Longitude - the ship’s current longitude, in decimal degrees. East is defined positive.
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Ship Noise data consist of measurements that can be given for a user-defined number of
frequencies, ship speeds and sectors (relative bearings). For each of these combinations, the
noise measured at different depths can be registered. Use the Num Sectors to set the correct
number of sectors of ship noise measurements. The sectors are assumed evenly distributed
around the ship, so if you have measurements for every 10 degrees, you should set the number
of sectors to 36. The check box pr. Hz is used to indicate if the noise measurements is measured
pr. Hz or in a wider band.

Additional information about the noise measurements can be given in the following fields:

o Ship name - the ship on which the measurements were done; not necessarily the same as
the current ship.

e Date - date of measurements.

o Latitude- the ship’s latitude during measurement, in decimal degrees. North is defined
positive.

o Longitude - the ship’s longitude during measurement, in decimal degrees. East is
defined positive.

Several sonars can be associated to a ship. Select the current sonar and use the Edit Sonar button
to invoke the sonar editor where data for each sonar can be entered (see Section 7.3). The part of
the Ship Editor that associates sonars to the ship is shown in Figure 7.3.

You can save the ship data as a file by pressing the Save button, find a suitable location for the
file and click Save again. To load an existing set of ship data, click Open, select the file and
click Open again. Data about the sonars attached to the ship is also stored together with the ship
data, so that the next time you load a ship, all of its associated sonars are loaded also.

Click OK to accept changes and return to the sonar self noise editor, or Cance! to discard
changes.
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¥, ship Editor

Ship Parameters

Ship Mame: |Test ship | Course [deg]: 0.0 Latitude [deg N]: 60,1000 =

Ship Type: |:’-‘-.|.rt|:| generated | Speed [knots]: 10015 Longitude [deg EJ: 4400013

Ship Moise Measurements

Sonar Depth [m] Frequency [Hz] Ship Speed [knots] Mum Sectors: 4= [ pr. He
80.0 % 7000 =5 100
Sector [deq] Ship Moise [dB]
| | ' X O
of 1 db of 1 ok ofd4 p| db 90 40
MNoise Measurement at 180 20
Ship Name: [My ship | Latiude: 60,1000/= 270 40
Date: | 18.02.2023 | Longtude: 4.4000}5 . S
Sonar

Curert: [4 4 2 of 2 b % Name: Edit Sonar
Save oK Cancel

Figure 7.2 The Ship Editor lets the user inspect, alter or create the ship parameters. It is
the ship noise profile for various speeds, frequencies and sonar depths that is
used in calculations.

Sonar

Curent: [4 4 |2 of 2 db % Name: Edit Sonar

Figure 7.3 Step between the sonars associated with the ship and use the Edit Sonar button
to invoke the sonar editor.

7.3 Sonar editor
The Sonar Editor is the editor where one in detail defines parameters for a new sonar. The Sonar

Editor can be invoked by selecting the Edit Sonar button in the Sonar Self Noise window, or by
selecting the Edit Sonar button in the Ship Editor Window. The editor is shown in Figure 7.4.
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M. sonar Editor

Sonar parameters
Sonar Name: |defauhsonar | Sidelobe Transmitter [dB]: 1305
Sidelobe Receiver [dB]: 13.0=
Depth [m]
Defautt: 50/ Fixed Beamwidth Transmitter [deq]: 150
Limits: I 5.0/ Beamwidth Receiver [deq]: 150~
Titt [deq] Rel. Bearing [deq]: 450
Defaults:
Tik Fixed Calib Factor [dB] 0.0k
Transm: 40 ! —
Min {down): 4015 Diet. Threshold [dE]: 10,0k
Rec: 40= —
Max {up): 4015 System Loss [dB]: 0.0}
Passive Operation
Mamow-band Bandwidth [Hz]: 100.0=- | Integration Time [s]: 1.0
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Figure 7.4 The Sonar Editor lets the user view and alter the sonar parameters. The user
may also use the editor to create new sonar parameter profiles.
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The following commands are available:

e Open - lets the user open a previously saved sonar file. All sonar parameters will be
loaded.

e Save - lets the user save all parameters for the current sonar as an XML sonar file. Note
that this will save the sonar data to a separate XML file. If you want to attach it to a
ship, you have to use the Save button in the ship editor (see Section7.2).

e OK - uses the defined parameters as data for the current sonar.

e Cancel - discards the changes.

Sonar parameters include:
e  Sonar Name - the type of the sonar.

e Depth Fixed - indicates whether the sonar has a variable transducer depth or a fixed
transducer depth ( i.e. hull mounted sonars).

e Depth Default - the fixed depth for fixed-depth sonars. The current depth for variable
depth sonars. All depths are in meters.

e  Depth Limits - the minimum and maximum depth of a variable depth sonar.
o Tilt Fixed - indicates whether the sonar has variable tilt angle or a fixed tilt angle.

o Tilt Transmitter - the fixed tilt angle for fixed-tilt sonars. The current tilt for variable tilt
sonars. Tilts are measured in degrees, positive angles are defined upwards.

o Tilt Receiver - the fixed tilt angle for fixed-tilt sonars. The current tilt for variable tilt
sonars. Tilts are measured in degrees, positive angles are defined upwards.

e Tilt Min (down) - the negative (downward) tilt limit for variable tilt sonars.

o Tilt Max (up) - the positive (upward) tilt limit for variable tilt sonars.

e Sidelobe transmitter - the vertical sidelobe suppression of the transmitter. The sidelobe
suppression indicates the suppression (in dB) of the first sidelobe of the sonar relative to

the centre of the beam. High figures give one-beam-only sonars, whereas low figures
give visible sidelobes.
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o Sidelobe receiver - the vertical sidelobe suppression of the receiver. The sidelobe
suppression indicates the suppression (in dB) of the first sidelobe of the sonar relative to
the centre of the beam. High figures give one-beam-only sonars, whereas low figures
give visible sidelobes.

e Beam width transmitter - indicates the vertical beam width (in degrees) of the
transmitter beam.

e Beam width receiver - indicates the vertical beam width (in degrees) of the receiver
beam.

® Rel. Bearing - Indicates the direction (relative to the ship) at which the transducer is
currently pointing. Given in degrees.

e (Calib.Factor - the calibration factor (in dB) gives an opportunity to correct for
systematic errors. The calibration factor is not yet implemented but is displayed on the

GUI for future use.

o Detec.Threshold - the strength of the signal relative to the masking level necessary to
see an object with the sonar.

o System Loss - system loss due to special loss mechanisms in the sea or sonar system not
otherwise accounted for.

Some parameters are specific for passive sonar calculations. These are:
e Narrowband / Broadband — type of sonar.
e  Bandwidth — the bandwidth of the sonar.

e [ntegration Time — integration time during passive mode.

A sonar can have different source levels and directivity indexes for a set of frequencies and
modes. These can be edited using the following buttons:

e Freq - the current frequency (in kHz).
o Use the plus sign to select the number of frequencies on this sonar.
o Use the arrows to select which frequency is currently in use.

o Use the cross to delete a frequency.

46 FFI-RAPPORT 24/00023



Mode - name of the current mode.
o Use the plus sign to select the number of modes on this sonar.
o Use the arrows to select which mode is currently in use.
o Use the cross to delete a mode.

Directivity Index - is the beam pattern’s ability to suppress isotropic noise relative to the
response in the steering direction.

Source Level - the source level of the sonar with the currently selected mode and
frequency. The source level (in dB) is the output volume of the sonar.

A sonar can have a number of different pulse types. In LYBIN several pulses can be defined,
and the parameters for them are edited using the following buttons:

Use the plus sign to select the number of pulses.

Use the arrows to select which pulse is currently in use.

Use the cross to delete a pulse.

Envelope Function - the Envelope Function for the currently selected pulse.

Pulse Form - pulse form of the currently selected pulse. The pulse form can be selected
by pressing the arrow down button to get a list of the available pulse forms, which are
CW and FM at present.

Pulse Length - the length (in ms) of the currently selected pulse.

Filter Bandwidth - the filter bandwidth (in Hz) of the currently selected pulse.

FM Bandwidth - the FM modulation bandwidth (in Hz) of the currently selected pulse.

Note that this value is only applicable to FM pulses. The field will be grayed out if any
of the other pulse forms are selected.

Be aware that:

Data about sonars can be stored in separate files, but to attach them to a ship you have to first
start the ship editor (see section 7.1) and then launch the Sonar Editor from there. When you
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have finished editing sonar parameters, press the Ok button and go back to the ship editor where
you save all the ship’s data, including the sonar(s), on a ship file by pressing the Save button. In
this way, the sonar(s) you have defined will be loaded with the ship every time LYBIN is run.

Saving sonar data on a separate file is useful if you are going to attach the same sonar to several
ships. Then you can load its definition from the sonar file for each ship, and avoid retyping the
same parameters repeatedly.

8 Environment editors

While the parameter settings that can be performed via the main screen can be considered as
quick to use and easily accessible, the parameter editors offer in-depth specification of model
parameters. The parameter editors are described below.

LYBIN is able to handle range dependent environments. In LYBIN, range dependent
environmental data is specified for certain range intervals from the sonar. When the
environmental properties are entered for a discrete set of locations (ranges), LYBIN will create
values at intermediate ranges using interpolation. If no environmental descriptions are given at
zero range, LYBIN will substitute the data for the nearest range available, likewise if data at
maximum range is missing.

Except for BottomProfile and ReverberationAndNoiseMeasurement, the range dependent data
are given with start and stop values to indicate their range of validity. In this context, we call
these datasets, with start and stop related to a value (or a set of values), for range dependent
data. A range dependent dataset can contain one or more values with their range of validity. The
possible number of values to be used in the calculation is only limited by the calculation
accuracy.

The start and stop functionality provides great flexibility in defining the environmental range
dependent properties. By setting start equal to stop, the data will be considered to belong to a
point in space, and LYBIN will use interpolation to produce data for intermediate ranges points.
The start and stop functionality might be utilized to illustrate meteorological or oceanographic
fronts, entering ranges with finite ranges of validity to each side of the front, and separating the
sets by any small distance, across which the conditions will change as abruptly as the user
intends. In between these two extreme choices, any combination of these can be used.

The user is responsible for ensuring that the ranges of validity do not overlap. If they do
overlap, the calculation kernel LybinCom, uses the first profile until its end range.
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8.1 Environment editor

The environment editor shows all the environmental input in one single plot, as can be seen in
Figure 8.1. The Environment Editor can be invoked by selecting

Edit --> Environment

or by clicking the . icon on the toolbar.

¥\, Environment Editor

tem '
0 1 2 3 4 a5 [} 7 2 9 10 Open Editor for...
. Pt Wind Speed
— 1510 G Trzm
30 + + + + o + +
1505 Volume Backscatter
100 1500
. * ¥ * 1495 Bottom Profile
120 w + + + + + + 1420 Bottom Type
1485
Bottom Bachkscatter
200 + + + + + + + + 1430
1475 Bottom Loss
230 * ¥ * + & + + & 3 1470 Reverberation=Noise
b .
300
m
Model Scales
Range: 10000+ 1= 10000} Allow Zoom
Depth: 3005 0= 300 2 Il Clear Il
Environment
Save oK Cancel
Figure 8.1 The Environment Editor contains all editors for environmental input data. It

also includes a representation of the most basic profiles, including wind, sound
speed, bottom profile and bottom type.

The environmental editor has a big picture displaying all the environmental input parameters in
one single plot. Wind speed is shown by the waves at the top of the picture. Small waves
indicate little wind and larger waves indicate more wind. The sound speed is displayed as
profile lines and as colours through the water volume. The colour bar to the right shows the
relation between actual sound speed and colour. The sound speed profiles are not interpolated
further than the deepest input point, thus the profile lines are not drawn deeper, and the areas
deeper than the sound speed input are coloured dark blue. The bottom topography is shown at
the bottom of the picture with different shadings of grey indicating sediment type.
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When the mouse is moved over the plot, range and depth are displayed beneath the plot. While
the mouse is moved over the waves at the top of the plot, the wind speed at that range is
displayed. If the mouse is moved inside the water volume, the sound speed at that position is
shown. The bottom type will be displayed if the mouse is moved over the bottom area.

Each of the environmental parameter types has its own editor. These editors can be opened by
clicking on the buttons in the Open Editor for... group box. The available choices are:

o Wind Speed — Opens the Wind Speed Profile Editor. The wind speed is a function of
range. The Wind Speed Profile Editor is described in section 8.2.

o Sound Speed — Opens the Sound Speed Profile Editor. The sound speed in the water
volume is a function of range and depth. The Sound Speed Profile Editor is described in
section 8.3.

o JVolume Back Scatter — Opens the Volume Back Scatter Profile Editor. The volume back
scatter is a function of range and depth. The Volume Back Scatter Profile Editor is
described in section 8.8.

e Bottom Profile — Opens the Bottom Profile Editor. The bottom profile is a function of
range. The Bottom Profile Editor is described in section 8.4.

e Bottom Type — Opens the Bottom Type Profile Editor. The bottom type is a function of
range. The Bottom Type Profile Editor is described in section 8.5.

e Bottom Back Scatter — Opens the Bottom Back Scatter Profile Editor. The bottom back
scatter is a function of range and gracing angle. The Bottom Back Scatter Profile Editor
is described in section 8.9.

e Bottom Loss — Opens the Bottom Loss Profile Editor. The bottom loss is a function of
range and gracing angle. The Bottom Loss Profile Editor is described in section 8.6.

e  Reverberation + Noise — Opens the Reverberation And Noise Profile Editor. The

reverberation and noise is a function of range. The Reverberation And Noise Profile
Editor is described in section 8.7.

The parameters in the Model Scales group box control the area of the calculation. The
parameters controlling the calculation area are:

e Range —Maximal calculation range.

e  Depth — Maximal calculation depth.
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The area of interest may not be the entire calculation area. The user is therefore allowed to zoom
in on areas of particular interest. To open and close this feature, use the Allow Zoom/Normal
View button:

e Allow Zoom — Enables the Editable Area group box, and disables the Model Scales
group box.

e Normal View — Disables the Editable Area group box, and enables the Model Scales
group box.

The parameters in the Editable Area group box control the area to be seen in the plot in the
Environmental Editor. The parameters are:

e Range — Start and end range of visible area in meters.

e Depth — Start and end depth of the visible area in meters.

The remaining buttons are global and apply to all the environmental parameters:
e  (Clear Environment — Resets all environmental parameters to default settings.
e Open — Opens an environmental file in xml format.
e Save — Saves the environmental input parameters to file in xml format.
e Ok — Accepts current environmental input parameters and returns to the main screen.

e Cancel — Discards changes and returns to the main screen.

8.2 Wind Speed

Wind speed is the strength of the wind at the ocean surface. Strong wind means higher waves
and a deeper bubble layer which affects the energy loss near the sea surface, and affects the
scattering of reflected rays. Wind speed values can range from 0-100 m/s.

The Wind Speed Profile Editor can be invoked by selecting

Edit --> Wind Speed,

FFI-RAPPORT 24/00023 51



by clicking the asa icon on the toolbar or by selecting the Wind Speed button in the
Environment Editor. The editor is displayed in Figure 8.2.

The editor contains a table of Wind speed values with their corresponding ranges of validity.
Both the start and stop values specify horizontal distance from the sonar position. If no wind
speed is given, the editor contains the default wind speed. The wind speed table can be edited by
tabbing (pressing the tab key) through the fields in the table. To enter a new data row, click in
the next row or press the tab key from the rightmost field.

! § WindSpeed profile editor

Start [m] Stop [m] Wind speed [m/s]
1] 3000 B
3000 7000 &
8000 5000 9
3 7000 8000 |
*
Load Save oK Cancel

Figure 8.2 The WindSpeed profile editor is based on the common 2-dimentional editor,
where each wind speed value is valid within a range defined by the start and
stop values.

LYBIN provides an option to save the wind speed input information in an XML file. To save
the wind speed information, click Save beneath the table, find a suitable location for the file and
click Save again. To load an existing set of sound speed information, click Open, select the file
and click Open again.

Click the OK button to accept the current wind speeds and return to main screen. Otherwise,
click the Cancel button to discard changes and return to the main screen.
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8.3 Sound Speed

The sound speed in the water volume is a function of both range and depth. Since the sound
speed is most often measured as depth dependent profiles, LYBIN can handle multiple sound
speed profiles with their separate range dependent areas of validity. The dedicated editor is
displayed in Figure 8.3.

The Sound Speed Profile Editor can be invoked by selecting
Edit --> Sound Speed,

by clicking the [ icon on the toolbar or by selecting the Sound Speed button in the
Environment Editor.

The editor contains a graphical display of the input profiles to the left. Temperature, salinity and
sound speed profiles are all displayed if they are present in the input dataset. Temperatures are
coloured red, salinities are coloured green and sound speeds are coloured blue. The profile
values are displayed in the table in the middle of the editor, and additional information about the
profile are shown to the right.

If no sound speed profile is given, the editor contains the default profile. The default profile
consists of depth, temperature, salinity and sound speed. The user defined profiles, on the other
hand, do not need to contain more than depth and one of the other parameters. If no values are
typed into one or two columns, the valueless columns will be removed when the next row is
entered. Any single profile must have the same parameters throughout, though, i.e. the
parameters included in the first row sets the standard for all the other rows in the profile.

The profile can be edited by tabbing (pressing the tab key) through the fields in the table, see
Figure 8.4. To enter a new data row, click in the next row or press the tab key from the
rightmost field.

To add a new profile for another range, first set the range for the original profile by setting the
fields for Start and Stop. Then click the 77 icon beneath the table. A new table will now appear.
It can be edited with the same procedure as described earlier. Set the Start and Stop values for
this new profile and push OK. LYBIN will interpolate between any gaps in range. To delete the

current profile, click the *icon beneath the table. To step between the various profiles set
over a distance, use the arrows beneath the table, see Figure 8.5.

In addition to profiles set up in the editor, import of individual profiles in EDF format is
possible. This is a format used in SIPPICANs bathythermographs [10]. To import an EDF file,
click the Ficon beneath the table. A profile will then be added based on the information in
the file.
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In addition, the fields for time, latitude and longitude to the right in the editor will be set
automatically. The user must specify start and stop values for the profile.

LYBIN provides an option to save the total sound speed input information in an XML file. To
save the sound speed information, click Save beneath the profile’s graphical display, find a
suitable location for the file and click Save again. To load an existing set of sound speed

information, click Open, select the file and click Open again.

¥, sound Speed Profile Editor
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Figure 8.3 The Sound Speed Profile Editor lets the user either manually enter a profile, or
import from a file. The temperature, salinity and sound speed profiles are
displayed in the plot in the left part of the editor, while the editable data is
presented in the table in the middle of the editor. The editor also allows for
multiple profiles to be entered.
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Figure 8.4 Editing in the Sound Speed Profile Editor’s table.
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Figure 8.5 Stepping between profiles valid at different distances.

8.4 Bottom Profile
The bottom profile editor can be invoked by selecting
Edit --> Bottom Profile,

by clicking the icon sl on the toolbar, or by selecting the Bottom Profile button in the
Environment Editor. The editor is displayed in Figure 8.6.

The parameters in the Model Scales group box control the area of the calculation. The
parameters controlling the calculation area are:

e Range — Maximal calculation range.

e  Depth — Maximal calculation depth.

The area of interest may not be the entire calculation area. The user is therefore allowed to zoom
in on areas of particular interest. To open and close this feature, push the A/low Zoom/Normal
View button:

o Allow Zoom — Enables the Editable Area group box, and disables the Model Scales
group box.

e Normal View — Disables the Editable Area group box, and enables the Model Scales
group box.
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The parameters in the Editable Area group box control the area to be seen in the plot in the
Bottom Profile Editor. The parameters are:

e Range — Start and end range of visible area in meters.

e Depth — Start and end depth of the visible area in meters.
In order to optimize the calculation area according to the water volume of interest, there are two
options available:

e Adjust Scale — adjust the maximum calculation depth according to the lowest bottom
point. This function does not consider not-yet-accepted changes.

e (Clear Bottom - removes all points and sets the bottom as a straight line 10 m above the
bottom line of the view.

¥, Bottom Profile Editor
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Figure 8.6 The Bottom Profile Editor lets the user create, load, alter and save a bottom
profile. The vertices of the profile, displayed as circles, may be altered using the
mouse pointer.
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To save the bottom profile information to an XML file, click Save to the bottom left, find a
suitable location for the file and click Save again. To load an existing set of bottom profile
information, click Open, select the file and click Open again.

Bottom depths can also be inserted manually. Move the cursor to the desired co-ordinate and
click the left mouse button to insert a new point in the bottom profile. Each time a point has
been set, the editor draws a smooth path between the existing points. The physical location of
the cursor is shown below the view. Clicking the left mouse button on or near an existing point
lets the user change the location of this point. Clicking the right mouse button on or near one of
the registered points will remove it from the profile. Clicking the right mouse button anywhere
else in the plot reveals a context menu with the option to copy to clipboard.

When the mouse is moved over the plot, range and depth are displayed beneath the plot. The
bottom type will also be displayed if the mouse is moved over the bottom area.

Click the OK button to accept the current bottom topography and returns to main screen.
Otherwise, click the Cancel button to discard changes and return to the main screen.

8.5 Bottom Type

The geo-acoustic properties of the bottom can be coded by a single parameter in LYBIN: the
bottom type. Bottom types range from 1 to 9, where 1 represents a hard rock type of bottom
with low bottom reflection loss, while 9 represents a soft bottom with a high reflection loss. The
bottom types 1-9 are FNWC bottom provinces as described in[11]. In addition, bottom types 0
and 10 have been added, representing no loss and fully absorbing bottoms, respectively. Bottom
type is the default way to describe sea floor acoustical properties in LYBIN.

The Bottom Type Profile Editor can be invoked by selecting
Edit --> Bottom Type,

by clicking the rlii1 icon on the toolbar, or by selecting the Bottom Type button in the
Environment Editor. The editor is displayed in Figure 8.7.

The editor contains a table of bottom type values with their corresponding ranges of validity.
Both the start and stop values specify horizontal distance from the sonar position. If no bottom
type is given, the editor contains the default bottom type. The bottom type table can be edited by
tabbing (pressing the tab key) through the fields in the table. To enter a new data row, click in
the next row or press the tab key from the rightmost field.

LYBIN provides an option to save the bottom type input information in an XML file. To save
the bottom type information, click Save beneath the table, find a suitable location for the file and
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click Save again. To load an existing set of bottom type information, click Open, select the file
and click Open again.

Click the OK button to accept the current bottom type and return to main screen. Otherwise,
click the Cancel button to discard changes and return to the main screen.

! Bottomn Type profile editor
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Figure 8.7 The BottomType profile editor is based on the common 2-dimentional editor,
where each bottom type value is valid within a range defined by the start and
stop values.

8.6 Bottom Loss

Bottom loss is the fraction of energy that is lost when the sound is reflected from the ocean
bottom, usually expressed in dB. The bottom loss is also referred to as forward scattering in
underwater acoustic terminology. Bottom loss is generally a function of sediment type, gracing
angle and frequency. A dataset representing bottom loss is entered into LYBIN in tabular form,
giving bottom loss (in dB) for a set of grazing angles. Based on the tabulated values, LYBIN
interpolates to create loss values for equidistantly spaced grazing angles.

The use of bottom loss values is optional in LYBIN. The checkbox Use measured bottom loss
(see section 6.3.4) located in the tab for Model Parameters, tells LYBIN to use the given bottom
loss values instead of calculating them from the specified bottom type. The dedicated editor is
displayed in Figure 8.8.
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Figure 8.8 The Bottom Loss Profile Editor lets the user either manually enter a profile, or
import from a file. The editor allows multiple profiles of loss values as function
of gracing angle to be entered with different ranges of validity.

The Bottom Loss Profile Editor can be invoked by selecting
Edit --> Bottom Loss,

by clicking the £ icon on the toolbar, or by selecting the Bottom Loss button in the
Environment Editor.

The editor allows multiple profiles of loss values as function of gracing angle to be entered with
different ranges of validity. The range of validity for each profile is given by the start and stop

values. New tables can be added by pressing the " button.

The profile can be edited by tabbing (pressing the tab key) through the fields in the table. To
enter a new data row, click in the next row or press the tab key from the rightmost field. To add
a new profile for another range, first set the range for the original profile by setting the fields for
Start and Stop. Then click the " icon beneath the table. A new table will now appear. It can be

FFI-RAPPORT 24/00023 59



edited with the same procedure as described earlier. Set the Start and Stop values for this new
profile and push OK. LYBIN will interpolate between any gaps in range. To delete the current

profile, click the 7 icon beneath the table. To step between the various profiles set over a
distance, use the arrows beneath the table.

LYBIN provides an option to save the total bottom loss dataset in an XML file. To save the
data, click Save beneath the profile’s graphical display, find a suitable location for the file and
click Save again. To load an existing set of bottom loss data, click Open, select the file and click
Open again.

8.7 Reverberation and Noise

In some cases, measurements of reverberation and noise are available, and can be incorporated
directly in the calculation of signal excess and probability of detection in LYBIN. Reverberation
and noise input values can consist of any number of measurements with corresponding ranges.
To find values for the ranges not given as measurements, LYBIN uses linear interpolation.

Reverberation and noise input is an alternative where measured values are used instead of
letting LYBIN estimate reverberation and noise. LYBIN will only use the reverberation and
noise input values if Rev and noise calculation type is set to Measured rev and noise as
described in section 6.3.4.

The Reverberation And Noise Profile Editor can be invoked by selecting
Edit --> Reverberation and noise,

by clicking the FEY icon on the toolbar, or by selecting the Reverberation+Noise button in the
Environment Editor. The editor is displayed in Figure 8.9.

The editor contains a table of reverberation and noise values with their corresponding distances
from the sonar. To enter a new data row, click in the next row or press the tab key from the
rightmost field.

LYBIN provides an option to save the reverberation and noise input information as an XML
file. To save the reverberation and noise information, click Save beneath the table, find a
suitable location for the file and click Save again. To load an existing set of reverberation and
noise information, click Open, select the file and click Open again.

Click the OK button to accept the current reverberation and noise and return to main screen.
Otherwise, click the Cancel button to discard changes and return to the main screen.
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Figure 8.9 The ReverberationAndNoise profile editor is based on the 2-dimensional editor,
where each reverberation and noise value is valid for a single position.

8.8 Volume Back Scatter

Volume back scatter is the fraction of energy scattered back towards the receiver from the sea
volume. Scattering elements in the sea volume can be particles or organic life, like plankton,
fish or sea mammals. The volume back scatter is not distributed uniformly in the sea, and can
vary considerably as a function of depth, and also on range and time of the day. In LYBIN, the
volume back scatter is given as back scattering coefficients as a function of depth. To find
scatter values for the depths not given, linear interpolation is used. The validity range of each
profile will be given by the corresponding start range and stop range values. The dedicated
editor is displayed in Figure 8.10.

The Volume Back Scatter Profile Editor can be invoked by selecting
Edit --> Volume Back scatter,

wolB
by clicking the ==t icon on the toolbar, or by selecting the Volume Back scatter button in the
Environment Editor.

The editor allows multiple profiles of scatter values as function of depth to be entered with
different ranges of validity. The range of validity for each profile is given by the start and stop

values. New tables can be added by pressing the " button.
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The profile can be edited by tabbing (pressing the tab key) through the fields in the table. To
enter a new data row, click in the next row or press the tab key from the rightmost field. To add
a new profile for another range, first set the range for the original profile by setting the fields for
Start and Stop. Then click the 77 icon beneath the table. A new table will now appear. It can be
edited with the same procedure as described earlier. Set the Start and Stop values for this new
profile and push OK. LYBIN will interpolate between any gaps in range. To delete the current

profile, click the x icon beneath the table. To step between the various profiles set over a
distance, use the arrows beneath the table.

LYBIN provides an option to save the total volume back scatter dataset in an XML file. To save
the data, click Save beneath the profile’s graphical display, find a suitable location for the file
and click Save again. To load an existing set of volume back scatter data, click Open, select the
file and click Open again.
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Figure 8.10  The Volume Back Scatter Profile Editor lets the user either manually enter a
profile, or import from a file. The editor allows multiple profiles of scatter
values as function of depth to be entered with different ranges of validity.
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8.9 Bottom Back Scatter

Bottom back scatter is the fraction of energy that is scattered back towards to the receiver when
a ray hits the sea bottom. The bottom back scatter is a function of sediment type, grazing angle
and frequency. A dataset representing bottom back scatter coefficients is entered into LYBIN in
tabular form, giving back scattering coefficients (in dB) for a set of grazing angles. Based on the
tabulated values, LYBIN interpolates between tabulated values to create back scatter
coefficients for equidistantly spaced grazing angles. The back scatter coefficients are given as
dB per square meter.

Bottom back scatter is an alternate way to calculate bottom reverberation. LYBIN will only use
the bottom back scatter values given if Rev and noise calculation type is set to Bottom Back
Scatter as described in section 6.3.4.

M. Bottom Back Scatter Profile Editor
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Figure 8.11  The Bottom Back Scatter Profile Editor lets the user either manually enter a
profile, or import from a file. The editor allows multiple profiles of scatter
values as function of gracing angle to be entered with different ranges of
validity.
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The Bottom Back Scatter Profile Editor is displayed in Figure 8.11 and can be invoked by
selecting

Edit --> Bottom Back scatter,

EE
Seadl

by clicking the
Environment Editor.

icon on the toolbar, or by selecting the Bottom Back scatter button in the

The editor allows multiple profiles of scatter values as function of gracing angle to be entered
with different ranges of validity. The range of validity for each profile is given by the start and

=i
LI

stop values. New tables can be added by pressing the button.

The profile can be edited by tabbing (pressing the tab key) through the fields in the table. To
enter a new data row, click in the next row or press the tab key from the rightmost field. To add
a new profile for another range, first set the range for the original profile by setting the fields for
Start and Stop. Then click the 77 icon beneath the table. A new table will now appear. It can be
edited with the same procedure as described earlier. Set the Start and Stop values for this new
profile and push OK. LYBIN will interpolate between any gaps in range. To delete the current

profile, click the 7 icon beneath the table. To step between the various profiles set over a
distance, use the arrows beneath the table.

LYBIN provides an option to save the total bottom back scatter dataset in an XML file. To save
the data, click Save beneath the profile’s graphical display, find a suitable location for the file
and click Save again. To load an existing set of bottom back scatter data, click Open, select the
file and click Open again.

8.10 Target Strength Table

Target Strength is the relation between the incoming and the returned echo from the target. A
value of -15 means that the intensity reflected from this particular target is 15 dB less than the
incoming signal. This parameter is used in the sonar equation for active sonars.

The target strength is a function of frequency and the aspect angle of the target, seen from the
sonar platform. The aspect angle can be from 0-359°. If only values less than 180° are given in
the table, the target strength values are reflected symmetrically through the longitudinal axis of
the target. Each target strength table has a valid frequency range with a given minimum and
maximum frequency.

The actual aspect angle to be used in the simulation is given by the parameter Target Aspect
Angle as described in section 6.2.1. The target strength table is an alternative way to set the
target strength. Whether LYBIN shall find target strength from the table or use the parameter
Target Strength, is given by the parameter Use measured target strength as described in section
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6.3.4. If Use measured target strength is true, the parameter Target Strength will be updated
with the target strength value that was actually used, found in the table based on frequency and
target aspect angle.

The Target strength table editor is displayed in Figure 8.12 and can be invoked by

1
clicking the @ icon on the toolbar.

The editor allows multiple tables of target strength values as function of aspect angle to be
entered with different frequency ranges of validity. The frequency range of validity for each
table is given by the start and stop values. New tables can be added by pressing the = button.

The table can be edited by tabbing (pressing the tab key) through the fields in the table. To enter
a new data row, click in the next row or press the tab key from the rightmost field. To add a new
table for another frequency range, first set the frequency range for the original table by setting
the fields for Start and Stop. Then click the 77 icon beneath the table. A new table will now
appear. It can be edited with the same procedure as described earlier. Set the Start and Stop
values for this new table and push OK. LYBIN will interpolate between any gaps in frequency

range. To delete the current table, click the 7 icon beneath the table. To step between the
various tables, use the arrows beneath the table.

LYBIN provides an option to save the total target strength dataset in an XML file. To save the

data, click Save, find a suitable location for the file and click Save again. To load an existing set
of target strength data, click Open, select the file and click Open again.
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! § Target strength table editor
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Figure 8.12  The Target strength table editor lets the user either manually enter a profile, or
import from a file. The editor allows multiple tables of target strength values as
function of aspect angle to be entered with different ranges of validity.

9 Tactical decision aids

9.1 Find best sonar settings
The Find best sonar settings editor calculated the best sonar settings in the given environment.

The best sonar settings are here defined to be the values of sonar depth and tilt for both
transmitter and receiver that give the highest total signal excess in the area defined in the editor.
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If the check box Use all ranges and depths is checked, the entire area defined in the simulation
settings are used to find the best sonar settings. If the Range check box is checked, a smaller
area in range can be defined as the area where one wants to have as high signal excess as
possible. Likewise, if the Depth check box is checked, a smaller area in depth can be defined as
the area where one wants to have as high signal excess as possible.

The value range to search within to find the best settings can be chosen for each parameter by
the Min value and Max value parameters. The calculation process is started by pressing the Find
best sonar settings button.

When the best sonar settings calculation is finished, the Variability close to best is displayed.
The indicators Low (green) or High (red) indicate the variability in signal excess caused by each
parameter in the value range close to best.

After the calculation, the best value found is written both in the Min value and Max value
numeric up down box for each parameter. The best sonar settings found can be used to initiate a
new LYBIN calculation by pressing the Use best sonar settings button.

9.2 Predicted sonar range

The predicted sonar range editor shows the predicted sonar range (PSR) together with the sound
speed profile nearest the sonar and the most essential sonar parameters used in the calculation.
The predicted sonar range is presented as worst PSR and best PSR, using different colors in the
signal excess plot.

The worst predicted sonar range is the position with the longest horizontal continuous detection
range, defined by a signal excess above 5 dB. The first 1000 m is not included. Signal excess
values less than 5 dB for ranges shorter than 500 m are also overseen.

The best predicted sonar range is the position with the longest horizontal range from the sonar
with a signal excess higher than -5 dB.

The best listening depth (BLD) and best avoidance depth (BAD) is also included in the
predicted sonar range editor.

The content in the predicted sonar range editor can be saved as a .png file by pressing the save
button. The content can also be copied to the clipboard by pressing the copy button.
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10 Printing

LYBIN has functionality for printing the calculated plots. The functionality is found under the
File-menu, as Print... and Print preview.

Both options print the calculation result displayed in the upper right window within LYBIN in
multi-view mode. When in single view mode, the displayed result is printed.

The print preview functionality can be used for displaying how the selected calculation result
will appear printed on paper.

The print functionality will print the calculation results on a printer of choice

B piin previe
&L -| [0 B @ | o |

Ray trace

Figure 10.1  Screen-shot of the print preview window. The picture displays how the
calculated ray trace will appear on an A4 page.
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Appendix

A LYBIN XML format v3.0

This section contains supplementary material describing file format of LYBIN xml files.

A1 Complete model with default values

The parameters inside the tag MODELFILE are used in the calculation. The parameters inside
the tag Shiplnfo are optional.

<?xml version="1.0" encoding="utf-8"?>
<LYBINFILE xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<MODELFILE>
<MODELPARAMETERS>
<BOTTOMREVERBERATIONCALCULATION>true</BOTTOMREVERBERATIONCALCULATION>
<DEPTHCELLS>50</DEPTHCELLS>
<DEPTHCELLSIZE>6</DEPTHCELLSIZE>
<DEPTHSCALE>300</DEPTHSCALE>
<DEPTHSTEPS>1000</DEPTHSTEPS>
<DEPTHSTEPSIZE>0.28</DEPTHSTEPSIZE>
<IMPULSERESPONSECALCULATION>false</IMPULSERESPONSECALCULATION>
<IMPULSERESPONSEDEPTH>0</IMPULSERESPONSEDEPTH>
<MAXBORDERHITS>5000</MAXBORDERHITS>
<NOISECALCULATION>true</NOISECALCULATION>
<PASSIVECALCULATION>false</PASSIVECALCULATION>
<PROBABILITYOFDETECTIONCALCULATION>true</PROBABILITYOFDETECTIONCALCULATION>
<RANGECELLS>50</RANGECELLS>
<RANGECELLSIZE>200</RANGECELLSIZE>
<RANGESCALE>10000</RANGESCALE>
<RANGESTEPS>500</RANGESTEPS>
<RANGESTEPSIZE>20</RANGESTEPSIZE>
<RAYTRACECALCULATION>true</RAYTRACECALCULATION>
<SIGNALEXCESSCALCULATION>true</SIGNALEXCESSCALCULATION>
<SIGNALEXCESSCONSTANT>3</SIGNALEXCESSCONSTANT>
<SURFACEREVERBERATIONCALCULATION>true</SURFACEREVERBERATIONCALCULATION>
<TERMINATIONINTENSITY>1E-16</TERMINATIONINTENSITY>
TRANSMISSIONLOSSFROMTARGETCALCULATION>true</TRANSMISSIONLOSSFROMTARGETCALCULATION>
<TRANSMISSIONLOSSTOTARGETCALCULATION>true</TRANSMISSIONLOSSTOTARGETCALCULATION>
<TRAVELTIMEANGLERESOLUTION>1</TRAVELTIMEANGLERESOLUTION>
<TRAVELTIMECALCULATION>false</TRAVELTIMECALCULATION>
<TRLRAYS>1000</TRLRAYS>
<TYPEOFREVNOISECALCULATION>0</TYPEOFREVNOISECALCULATION>
<USEMEASUREDBOTTOMLOSS>false</USEMEASUREDBOTTOMLOSS>
<USEMEASUREDHORIZONTALBEAMWIDTH>false</USEMEASUREDHORIZONTALBEAMWIDTH>
<USEMEASUREDPASSIVEPROCESSINGGAIN>true</USEMEASUREDPASSIVEPROCESSINGGAIN>
<USERAYLEIGHBOTTOMLOSS>false</USERAYLEIGHBOTTOMLOSS>
<USEWAVEHEIGHT>false</USEWAVEHEIGHT>
<VISUALBOTTOMHITS>1</VISUALBOTTOMHITS>
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<VISUALNUMRAYS>50</VISUALNUMRAYS>
<VISUALRAYTRACECALCULATION>true</VISUALRAYTRACECALCULATION>
<VISUALSURFACEHITS>2</VISUALSURFACEHITS>
<VOLUMEREVERBERATIONCALCULATION>true</VOLUMEREVERBERATIONCALCULATION>
</MODELPARAMETERS>
<PLATFORMFILE>
<PLATFORMNAME />
<PLATFORMTYPE />
<LATITUDE>60.1</LATITUDE>
<LONGITUDE>4.4</LONGITUDE>
<COURSE>0</COURSE>
<SELFNOISE>50</SELFNOISE>
<SELFNOISEPASSIVE>50</SELFNOISEPASSIVE>
<SPEED>10</SPEED>
<SENSORFILE>
<BEAMWIDTHHORIZONTAL>20</BEAMWIDTHHORIZONTAL>
<BEAMWIDTHRECEIVER>15</BEAMWIDTHRECEIVER>
<BEAMWIDTHTRANSMITTER>15</BEAMWIDTHTRANSMITTER>
<CALIBRATIONFACTOR>0</CALIBRATIONFACTOR>
<DEPTH>5</DEPTH>
<DETECTIONTHRESHOLD>10</DETECTIONTHRESHOLD>
<DIRECTIVITYINDEX>20</DIRECTIVITYINDEX>
<FREQUENCY>7000</FREQUENCY>
<INTEGRATIONTIMEPASSIVE>1</INTEGRATIONTIMEPASSIVE>
<PASSIVEBANDWIDTH>100</PASSIVEBANDWIDTH>
<PASSIVEFREQUENCY>800</PASSIVEFREQUENCY>
<PASSIVEPROCESSINGGAIN>6.54</PASSIVEPROCESSINGGAIN>
<SIDELOBERECEIVER>13</SIDELOBERECEIVER>
<SIDELOBETRANSMITTER>13</SIDELOBETRANSMITTER>
<SONARTYPEPASSIVE>0</SONARTYPEPASSIVE>
<SOURCELEVEL>221</SOURCELEVEL>
<SOURCELEVELPASSIVE>150</SOURCELEVELPASSIVE>
<SYSTEMLOSS>0</SYSTEMLOSS>
<TILTRECEIVER>4</TILTRECEIVER>
<TILTTRANSMITTER>4</TILTTRANSMITTER>
<PULSE>
<ENVELOPEFUNC>Hann</ENVELOPEFUNC>
<FILTERBANDWIDTH>100</FILTERBANDWIDTH>
<FMBANDWIDTH>100</FMBANDWIDTH>
<FORM>FM</FORM>
<LENGTH>60</LENGTH>
</PULSE>
</SENSORFILE>
</PLATFORMFILE>
<ENVIRONMENTFILE>
<BOTTOMFILE>
<BOTTOMPROFILE>
<RANGE>0</RANGE>
<DEPTH>280</DEPTH>
</BOTTOMPROFILE>
</BOTTOMFILE>
<BOTTOMTYPEFILE>
<BOTTOMTYPE>
<START>0</START>
<STOP>0</STOP>
<TYPE>4</TYPE>
</BOTTOMTYPE>
</BOTTOMTYPEFILE>
<OCEANFILE>
<AMBIENTNOISELEVEL>50</AMBIENTNOISELEVEL>
<PH>8</PH>
<PRECIPITATIONNOISETYPE>0</PRECIPITATIONNOISETYPE>
<REVERBERATIONZONE>1</REVERBERATIONZONE>
<SHIPDENSITY>4</SHIPDENSITY>
<SOURCELEVELTARGET>10</SOURCELEVELTARGET>
<SURFACESCATTERFLAG>true</SURFACESCATTERFLAG>
<TARGETSTRENGTH>10</TARGETSTRENGTH>
</OCEANFILE>
<RAYLEIGHBOTTOMLOSSFILE>
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<BOTTOMATTENUATION>0.5</BOTTOMATTENUATION>
<BOTTOMSOUNDSPEED>1700</BOTTOMSOUNDSPEED>
<DENSITYRATIO>2</DENSITYRATIO>
</RAYLEIGHBOTTOMLOSSFILE>
<SOUNDSPEEDPROFILE>
<START>0</START>
<STOP>1000</STOP>
<PROFILE>
<DEPTH>0</DEPTH>
<TEMPERATURE>7.36</TEMPERATURE>
<SALINITY>35</SALINITY>
<SOUNDVELOCITY>1480</SOUNDVELOCITY>
</PROFILE>
</SOUNDSPEEDPROFILE>
<VOLUMEBACKSCATTERFILE>
<VOLUMEBACKSCATTER>
<START>0</START>
<STOP>0</STOP>
<SCATTERDENOM>DB</SCATTERDENOM>
<VOLUMESCATTER>
<DEPTH>0</DEPTH>
<SCATTER>-92</SCATTER>
</VOLUMESCATTER>
</VOLUMEBACKSCATTER>
</VOLUMEBACKSCATTERFILE>
<WINDFILE>
<WIND>
<START>0</START>
<STOP>0</STOP>
<WINDSPEED>0</WINDSPEED>
</WIND>
</WINDFILE>
<LAMBERTSCOEFFICIENTFILE>
<LAMBERTSCOEFFICIENT>
<START>0</START>
<STOP>1000</STOP>
<COEFFICIENT>-27</COEFFICIENT>
</LAMBERTSCOEFFICIENT>
</LAMBERTSCOEFFICIENTFILE>
</ENVIRONMENTFILE>
</MODELFILE>
<ShipInfo>
<SHIPNAME>Lybin default ship</SHIPNAME>
<SHIPCLASS>Auto-generated</SHIPCLASS>
<COURSE>0</COURSE>
<SPEED>0</SPEED>
<LATITUDE>ON</LATITUDE>
<LONGITUDE>0E</LONGITUDE>
<SELFNOISE>
<SHIPNAME>defaultship</SHIPNAME>
<DATE>01-01-2009</DATE>
<LATITUDE>ON</LATITUDE>
<LONGITUDE>0E</LONGITUDE>
<NUMFREQUENCIES>1</NUMFREQUENCIES>
<NUMSPEEDS>1</NUMSPEEDS>
<NUMSECTORS>1</NUMSECTORS>
<NUMDEPTHS>1</NUMDEPTHS>
<FREQUENCIES>7000</FREQUENCIES>
<SPEEDS>10</SPEEDS>
<DEPTHS>5</DEPTHS>
<NOISEMATRIX>50</NOISEMATRIX>
</SELFNOISE>
<CURRENTSONAR>0</CURRENTSONAR>
<SONAR>
<SONARNAME>defaultsonar</SONARNAME>
<DEPTHFIXED>true</DEPTHFIXED>
<DEPTHMIN>5</DEPTHMIN>
<DEPTHMAX>5</DEPTHMAX>
<DEPTH>5</DEPTH>
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<TILTFIXED>true</TILTFIXED>
<TILTMIN>4</TILTMIN>

<TILTMAX>4</TILTMAX>
<TILTTRANSMITTER>4</TILTTRANSMITTER>
<TILTRECEIVER>4</TILTRECEIVER>
<SIDELOBETRANSMITTER>13</SIDELOBETRANSMITTER>
<SIDELOBERECEIVER>13</SIDELOBERECEIVER>
<CALIBRATIONFACTOR>0</CALIBRATIONFACTOR>
<DETECTIONTHRESHOLD>10</DETECTIONTHRESHOLD>
<SONARTYPEPASSIVE>0</SONARTYPEPASSIVE>
<INTEGRATIONTIMEPASSIVE>1</INTEGRATIONTIMEPASSIVE>
<PASSIVEBANDWIDTH>100</PASSIVEBANDWIDTH>
<BEAMWIDTHTRANSMITTER>15</BEAMWIDTHTRANSMITTER>
<BEAMWIDTHRECEIVER>15</BEAMWIDTHRECEIVER>

<RELATIVEBEARING>45</RELATIVEBEARING>
<SYSTEMLOSS>0</SYSTEMLOSS>
<CURRENTFREQUENCY>0</CURRENTFREQUENCY>
<CURRENTMODE>0</CURRENTMODE>
<CURRENTPULSE>0</CURRENTPULSE>
<NUMPULSES>1</NUMPULSES>
<NUMMODES>1</NUMMODES>
<NUMFREQUENCIES>1</NUMFREQUENCIES>
<PULSE>
<ENVELOPEFUNC>Hann</ENVELOPEFUNC>

<FILTERBANDWIDTH>100</FILTERBANDWIDTH>

<FMBANDWIDTH>100</FMBANDWIDTH>
<FORM>FM</FORM>
<LENGTH>60</LENGTH>
</PULSE>
<FREQUENCIES>7000</FREQUENCIES>
<DIRECTIVITY>20</DIRECTIVITY>
<MODES>"defaultmode"</MODES>
<SOURCELEVEL>221</SOURCELEVEL>
</SONAR>
</ShipInfo>
</LYBINFILE>

A.2 Wind Speed XML format

<?xml version="1.0" encoding="utf-8"?>

<WINDFILE xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"

xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<WIND>
<START>0</START>
<STOP>5000</STOP>
<WINDSPEED>6</WINDSPEED>
</WIND>
<WIND>
<START>5000</START>
<STOP>10000</STOP>
<WINDSPEED>8</WINDSPEED>
</WIND>
</WINDFILE>
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A3 Sound Speed XML format

<?xml version="1.0" encoding="utf-8"?>
<SOUNDSPEEDFILE xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<SOUNDSPEEDPROFILE>
<START>0</START>
<STOP>3500</STOP>
<PROFILE>
<DEPTH>0</DEPTH>
<TEMPERATURE>7.36366126149536</TEMPERATURE>
<SALINITY>35</SALINITY>
<SOUNDVELOCITY>1480</SOUNDVELOCITY>
</PROFILE>
<PROFILE>
<DEPTH>100</DEPTH>
<TEMPERATURE>7.36366126149536</TEMPERATURE>
<SALINITY>35</SALINITY>
<SOUNDVELOCITY>1500</SOUNDVELOCITY>
</PROFILE>
</SOUNDSPEEDPROFILE>
<SOUNDSPEEDPROFILE>
<START>4500</START>
<STOP>9500</STOP>
<PROFILE>
<DEPTH>35</DEPTH>
<SOUNDVELOCITY>1497</SOUNDVELOCITY>
</PROFILE>
<PROFILE>
<DEPTH>55</DEPTH>
<SOUNDVELOCITY>1499</SOUNDVELOCITY>
</PROFILE>
<PROFILE>
<DEPTH>75</DEPTH>
<SOUNDVELOCITY>1500</SOUNDVELOCITY>
</PROFILE>
</SOUNDSPEEDPROFILE>
</SOUNDSPEEDFILE>

A.4 Volume Back Scatter XML format

<?xml version="1.0" encoding="utf-8"?>
<VOLUMEBACKSCATTERFILE xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<VOLUMEBACKSCATTER>
<START>0</START>
<STOP>500</STOP>
<SCATTERDENOM>DB</SCATTERDENOM>
<VOLUMESCATTER>
<DEPTH>0</DEPTH>
<SCATTER>-96</SCATTER>
</VOLUMESCATTER>
<VOLUMESCATTER>
<DEPTH>23</DEPTH>
<SCATTER>-97</SCATTER>
</VOLUMESCATTER>
</VOLUMEBACKSCATTER>
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<VOLUMEBACKSCATTER>
<START>7000</START>
<STOP>10000</STOP>
<SCATTERDENOM>DB</SCATTERDENOM>
<VOLUMESCATTER>
<DEPTH>10</DEPTH>
<SCATTER>-91</SCATTER>
</VOLUMESCATTER>
<VOLUMESCATTER>
<DEPTH>50</DEPTH>
<SCATTER>-92</SCATTER>
</VOLUMESCATTER>
<VOLUMESCATTER>
<DEPTH>80</DEPTH>
<SCATTER>-94</SCATTER>
</VOLUMESCATTER>
</VOLUMEBACKSCATTER>

</VOLUMEBACKSCATTERFILE>

A5

Bottom Profile XML format

<?xml version="1.0" encoding="utf-8"?>

<BOTTOMFILE xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">

<FILEINFO>

<FORMATVERSION>3.00</FORMATVERSION>

</FILEINFO>

<BOTTOMPROFILE>
<RANGE>0</RANGE>
<DEPTH>280</DEPTH>

</BOTTOMPROFILE>

<BOTTOMPROFILE>
<RANGE>943.66200268268585</RANGE>
<DEPTH>275.23809671401978</DEPTH>

</BOTTOMPROFILE>

<BOTTOMPROFILE>
<RANGE>2281.6900908946991</RANGE>
<DEPTH>252.3809552192688</DEPTH>

</BOTTOMPROFILE>

<BOTTOMPROFILE>
<RANGE>3661.9716882705688</RANGE>
<DEPTH>280.0000011920929</DEPTH>

</BOTTOMPROFILE>

<BOTTOMPROFILE>
<RANGE>5436.6195201873779</RANGE>
<DEPTH>280.0000011920929</DEPTH>

</BOTTOMPROFILE>

<BOTTOMPROFILE>
<RANGE>6352.112889289856</RANGE>
<DEPTH>252.3809552192688</DEPTH>

</BOTTOMPROFILE>

<BOTTOMPROFILE>
<RANGE>7309.8593950271606</RANGE>
<DEPTH>250.47619342803955</DEPTH>

</BOTTOMPROFILE>

<BOTTOMPROFILE>
<RANGE>7929.5772314071655</RANGE>
<DEPTH>282.85714387893677</DEPTH>

</BOTTOMPROFILE>

<BOTTOMPROFILE>
<RANGE>8633.80253314972</RANGE>
<DEPTH>288.57142925262451</DEPTH>

</BOTTOMPROFILE>

<BOTTOMPROFILE>
<RANGE>9098.5918045043945</RANGE>
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<DEPTH>264.76190686225891</DEPTH>
</BOTTOMPROFILE>
</BOTTOMFILE>

A.6 Bottom Type XML format

<?xml version="1.0" encoding="utf-8"?>
<BOTTOMTYPEFILE xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<BOTTOMTYPE>
<START>0</START>
<STOP>300</STOP>
<TYPE>4</TYPE>
</BOTTOMTYPE>
<BOTTOMTYPE>
<START>300</START>
<STOP>4300</STOP>
<TYPE>6</TYPE>
</BOTTOMTYPE>
<BOTTOMTYPE>
<START>5300</START>
<STOP>10000</STOP>
<TYPE>5</TYPE>
</BOTTOMTYPE>
</BOTTOMTYPEFILE>

A7 Bottom Back Scatter XML format

<?xml version="1.0" encoding="utf-8"?>
<BOTTOMBACKSCATTERINGFILE xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<BOTTOMBACKSCATTERING>
<START>0</START>
<STOP>5000</STOP>
<ANGLEDENOM>DEG</ANGLEDENOM>
<SCATTERDENOM>DB</SCATTERDENOM>
<BOTTOMSCATTER>
<ANGLE>0</ANGLE>
<SCATTER>40</SCATTER>
</BOTTOMSCATTER>
<BOTTOMSCATTER>
<ANGLE>50</ANGLE>
<SCATTER>42</SCATTER>
</BOTTOMSCATTER>
</BOTTOMBACKSCATTERING>
<BOTTOMBACKSCATTERING>
<START>5000</START>
<STOP>10000</STOP>
<ANGLEDENOM>DEG</ANGLEDENOM>
<SCATTERDENOM>DB</SCATTERDENOM>
<BOTTOMSCATTER>
<ANGLE>0</ANGLE>
<SCATTER>46</SCATTER>
</BOTTOMSCATTER>
<BOTTOMSCATTER>
<ANGLE>77</ANGLE>
<SCATTER>41</SCATTER>

FFI-RAPPORT 24/00023 75



</BOTTOMSCATTER>
<BOTTOMSCATTER>
<ANGLE>80</ANGLE>
<SCATTER>40</SCATTER>
</BOTTOMSCATTER>
</BOTTOMBACKSCATTERING>
</BOTTOMBACKSCATTERINGFILE>

A.8 Bottom Loss XML format

<?xml version="1.0" encoding="utf-8"?>
<BOTTOMLOSSFILE xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<BOTTOMLOSS>
<START>100</START>
<STOP>3000</STOP>
<ANGLEDENOM>DEG</ANGLEDENOM>
<LOSSDENOM>DB</LOSSDENOM>
<VALUE>
<ANGLE>0</ANGLE>
<L0SS>22</L0OSS>
</VALUE>
<VALUE>
<ANGLE>22</ANGLE>
<L0OSS>33</LOSS>
</VALUE>
<VALUE>
<ANGLE>45</ANGLE>
<L0OSS>40</LOSS>
</VALUE>
</BOTTOMLOSS>
<BOTTOMLOSS>
<START>3500</START>
<STOP>8000</STOP>
<ANGLEDENOM>DEG</ANGLEDENOM>
<LOSSDENOM>DB</LOSSDENOM>
<VALUE>
<ANGLE>0</ANGLE>
<L0SS>40</L0OSS>
</VALUE>
<VALUE>
<ANGLE>24</ANGLE>
<L0SS>37</L0OSS>
</VALUE>
</BOTTOMLOSS>
</BOTTOMLOSSFILE>

A.9 Reverberation and noise XML format

<?xml version="1.0" encoding="utf-8"?>
<REVANDNOISEFILE xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<REVERBERATIONANDNOISE>
<RANGE>0</RANGE>
<VALUE>80</VALUE>
</REVERBERATIONANDNOISE>
<REVERBERATIONANDNOISE>
<RANGE>1000</RANGE>
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<VALUE>80</VALUE>
</REVERBERATIONANDNOISE>
<REVERBERATIONANDNOISE>
<RANGE>2000</RANGE>
<VALUE>77</VALUE>
</REVERBERATIONANDNOISE>
<REVERBERATIONANDNOISE>
<RANGE>8000</RANGE>
<VALUE>54</VALUE>
</REVERBERATIONANDNOISE>
</REVANDNOISEFILE>

A.10 Target strength XML format

<TARGETSTRENGTHFILE>
<TARGETSTRENGTH>

<FREQUENCYRANGESTART>0</FREQUENCYRANGESTART>

<FREQUENCYRANGESTOP>1000</FREQUENCYRANGESTOP>

<ANGLEDENOM>DEG</ANGLEDENOM>

<STRENGTHDENOM>DB</STRENGTHDENOM>

<VALUE>
<ASPECTANGLE>0</ASPECTANGLE>
<STRENGTH>10</STRENGTH>

</VALUE>

<VALUE>
<ASPECTANGLE>20</ASPECTANGLE>
<STRENGTH>10</STRENGTH>

</VALUE>

<VALUE>
<ASPECTANGLE>40</ASPECTANGLE>
<STRENGTH>35</STRENGTH>

</VALUE>

<VALUE>
<ASPECTANGLE>60</ASPECTANGLE>
<STRENGTH>10</STRENGTH>

</VALUE>

</TARGETSTRENGTH>
<TARGETSTRENGTH>

<FREQUENCYRANGESTART>1000</FREQUENCYRANGESTART>

<FREQUENCYRANGESTOP>2000</FREQUENCYRANGESTOP>

<ANGLEDENOM>DEG</ANGLEDENOM>

<STRENGTHDENOM>DB</STRENGTHDENOM>

<VALUE>
<ASPECTANGLE>0</ASPECTANGLE>
<STRENGTH>10</STRENGTH>

</VALUE>

<VALUE>
<ASPECTANGLE>10</ASPECTANGLE>
<STRENGTH>15</STRENGTH>

</VALUE>

<VALUE>
<ASPECTANGLE>20</ASPECTANGLE>
<STRENGTH>18</STRENGTH>

</VALUE>

<VALUE>
<ASPECTANGLE>60</ASPECTANGLE>
<STRENGTH>22</STRENGTH>

</VALUE>

<VALUE>
<ASPECTANGLE>80</ASPECTANGLE>
<STRENGTH>25</STRENGTH>

</VALUE>

<VALUE>
<ASPECTANGLE>140</ASPECTANGLE>
<STRENGTH>20</STRENGTH>

</VALUE>
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<VALUE>
<ASPECTANGLE>160</ASPECTANGLE>
<STRENGTH>16</STRENGTH>
</VALUE>
<VALUE>
<ASPECTANGLE>170</ASPECTANGLE>
<STRENGTH>15</STRENGTH>
</VALUE>
</TARGETSTRENGTH>

</TARGETSTRENGTHFILE>

A.11 Ship XML format

<?xml version="1.0"?2>
<SHIPFILE xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<SHIP>
<SHIPNAME>Lybin ship</SHIPNAME>
<SHIPCLASS>Auto-generated</SHIPCLASS>
<COURSE>10</COURSE>
<SPEED>5</SPEED>
<LATITUDE>ON</LATITUDE>
<LONGITUDE>0E</LONGITUDE>
<SELFNOISE>
<SHIPNAME>defaultship</SHIPNAME>
<DATE>01-01-2009</DATE>
<LATITUDE>ON</LATITUDE>
<LONGITUDE>0E</LONGITUDE>
<NUMFREQUENCIES>1</NUMFREQUENCIES>
<NUMSPEEDS>1</NUMSPEEDS>
<NUMSECTORS>4</NUMSECTORS>
<NUMDEPTHS>1</NUMDEPTHS>
<FREQUENCIES>7000</FREQUENCIES>
<SPEEDS>10</SPEEDS>
<DEPTHS>5</DEPTHS>
<NOISEMATRIX>50 20 50 20</NOISEMATRIX>
</SELFNOISE>
<CURRENTSONAR>1</CURRENTSONAR>
<SONAR>
<SONARNAME>Sonarl</SONARNAME>
<DEPTHFIXED>true</DEPTHFIXED>
<DEPTHMIN>5</DEPTHMIN>
<DEPTHMAX>5</DEPTHMAX>
<DEPTH>5</DEPTH>
<TILTFIXED>true</TILTFIXED>
<TILTMIN>4</TILTMIN>
<TILTMAX>4</TILTMAX>
<TILTTRANSMITTER>4</TILTTRANSMITTER>
<TILTRECEIVER>4</TILTRECEIVER>
<SIDELOBETRANSMITTER>13</SIDELOBETRANSMITTER>
<SIDELOBERECEIVER>13</SIDELOBERECEIVER>
<CALIBRATIONFACTOR>0</CALIBRATIONFACTOR>
<DETECTIONTHRESHOLD>10</DETECTIONTHRESHOLD>
<SONARTYPEPASSIVE>0</SONARTYPEPASSIVE>
<INTEGRATIONTIMEPASSIVE>1</INTEGRATIONTIMEPASSIVE>
<PASSIVEBANDWIDTH>100</PASSIVEBANDWIDTH>
<BEAMWIDTHTRANSMITTER>15</BEAMWIDTHTRANSMITTER>
<BEAMWIDTHRECEIVER>15</BEAMWIDTHRECEIVER>
<RELATIVEBEARING>45</RELATIVEBEARING>
<SYSTEMLOSS>0</SYSTEMLOSS>
<CURRENTFREQUENCY>0</CURRENTFREQUENCY>
<CURRENTMODE>0</CURRENTMODE >
<CURRENTPULSE>0</CURRENTPULSE>
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<NUMPULSES>1</NUMPULSES>
<NUMMODES>1</NUMMODES>
<NUMFREQUENCIES>1</NUMFREQUENCIES>
<PULSE>
<ENVELOPEFUNC>Hann</ENVELOPEFUNC>
<FILTERBANDWIDTH>100</FILTERBANDWIDTH>
<FMBANDWIDTH>100</FMBANDWIDTH>
<FORM>FM</FORM>
<LENGTH>60</LENGTH>
</PULSE>
<FREQUENCIES>7000</FREQUENCIES>
<DIRECTIVITY>20</DIRECTIVITY>
<MODES>"defaultmode"</MODES>
<SOURCELEVEL>221</SOURCELEVEL>
</SONAR>
<SONAR>
<SONARNAME>Sonar2</SONARNAME>
<DEPTHFIXED>true</DEPTHFIXED>
<DEPTHMIN>5</DEPTHMIN>
<DEPTHMAX>5</DEPTHMAX>
<DEPTH>5</DEPTH>
<TILTFIXED>false</TILTFIXED>
<TILTMIN>0</TILTMIN>
<TILTMAX>50</TILTMAX>
<TILTTRANSMITTER>0</TILTTRANSMITTER>
<TILTRECEIVER>0</TILTRECEIVER>
<SIDELOBETRANSMITTER>10</SIDELOBETRANSMITTER>
<SIDELOBERECEIVER>10</SIDELOBERECEIVER>
<CALIBRATIONFACTOR>0</CALIBRATIONFACTOR>
<DETECTIONTHRESHOLD>10</DETECTIONTHRESHOLD>
<SONARTYPEPASSIVE>0</SONARTYPEPASSIVE>
<INTEGRATIONTIMEPASSIVE>1</INTEGRATIONTIMEPASSIVE>
<PASSIVEBANDWIDTH>100</PASSIVEBANDWIDTH>
<BEAMWIDTHTRANSMITTER>55</BEAMWIDTHTRANSMITTER>
<BEAMWIDTHRECEIVER>25</BEAMWIDTHRECEIVER>
<RELATIVEBEARING>45</RELATIVEBEARING>
<SYSTEMLOSS>0</SYSTEMLOSS>
<CURRENTFREQUENCY>0</CURRENTFREQUENCY>
<CURRENTMODE>0</CURRENTMODE>
<CURRENTPULSE>1</CURRENTPULSE>
<NUMPULSES>2</NUMPULSES>
<NUMMODES>2</NUMMODES>
<NUMFREQUENCIES>2</NUMFREQUENCIES>
<PULSE>
<ENVELOPEFUNC>Hann</ENVELOPEFUNC>
<FILTERBANDWIDTH>500</FILTERBANDWIDTH>
<FMBANDWIDTH>100</FMBANDWIDTH>
<FORM>CW</FORM>
<LENGTH>75</LENGTH>
</PULSE>
<PULSE>
<ENVELOPEFUNC>Hann</ENVELOPEFUNC>
<FILTERBANDWIDTH>100</FILTERBANDWIDTH>
<FMBANDWIDTH>100</FMBANDWIDTH>
<FORM>FM</FORM>
<LENGTH>60</LENGTH>
</PULSE>
<FREQUENCIES>7000 4000</FREQUENCIES>
<DIRECTIVITY>22 20</DIRECTIVITY>
<MODES>"Model" "Mode2"</MODES>
<SOURCELEVEL>221 221 215 221</SOURCELEVEL>
</SONAR>
</SHIP>
</SHIPFILE>
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A.12 Sonar XML format

<?xml version="1.0"?2>

<SONARFILE xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"

xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">

<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>

</FILEINFO>

<SONAR>
<SONARNAME>Sonar2</SONARNAME >
<DEPTHFIXED>true</DEPTHFIXED>
<DEPTHMIN>5</DEPTHMIN>
<DEPTHMAX>5</DEPTHMAX>
<DEPTH>5</DEPTH>
<TILTFIXED>false</TILTFIXED>
<TILTMIN>0</TILTMIN>
<TILTMAX>50</TILTMAX>
<TILTTRANSMITTER>0</TILTTRANSMITTER>
<TILTRECEIVER>0</TILTRECEIVER>

<SIDELOBETRANSMITTER>10</SIDELOBETRANSMITTER>

<SIDELOBERECEIVER>10</SIDELOBERECEIVER>
<CALIBRATIONFACTOR>0</CALIBRATIONFACTOR>
<DETECTIONTHRESHOLD>10</DETECTIONTHRESHOLD
<SONARTYPEPASSIVE>0</SONARTYPEPASSIVE>

<INTEGRATIONTIMEPASSIVE>1</INTEGRATIONTIMEPASSIVE>

<PASSIVEBANDWIDTH>100</PASSIVEBANDWIDTH>

<BEAMWIDTHTRANSMITTER>55</BEAMWIDTHTRANSMITTER>

<BEAMWIDTHRECEIVER>25</BEAMWIDTHRECEIVER>
<RELATIVEBEARING>45</RELATIVEBEARING>
<SYSTEMLOSS>0</SYSTEMLOSS>
<CURRENTFREQUENCY>0</CURRENTFREQUENCY>
<CURRENTMODE>0</CURRENTMODE >
<CURRENTPULSE>1</CURRENTPULSE>
<NUMPULSES>2</NUMPULSES>
<NUMMODES>2</NUMMODES>
<NUMFREQUENCIES>2</NUMFREQUENCIES>
<PULSE>
<ENVELOPEFUNC>Hann</ENVELOPEFUNC>
<FILTERBANDWIDTH>500</FILTERBANDWIDTH>
<FMBANDWIDTH>100</FMBANDWIDTH>
<FORM>CW</FORM>
<LENGTH>75</LENGTH>
</PULSE>
<PULSE>
<ENVELOPEFUNC>Hann</ENVELOPEFUNC>
<FILTERBANDWIDTH>100</FILTERBANDWIDTH>
<FMBANDWIDTH>100</FMBANDWIDTH>
<FORM>FM</FORM>
<LENGTH>60</LENGTH>
</PULSE>
<FREQUENCIES>7000 4000</FREQUENCIES>
<DIRECTIVITY>22 20</DIRECTIVITY>
<MODES>"Model" "Mode2"</MODES>
<SOURCELEVEL>221 221 215 221</SOURCELEVEL>
</SONAR>
</SONARFILE>

>
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Abbreviations

COM  Component Object Model

EDF Exported Data Format

FFI Norwegian Defence Research Establishment
LYBIN LYdBane og INtensitetsprogram (acoustic model)
NDMA Norwegian Defence Materiel Agency

XML Extensible Markup Language
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